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Introduction To Safety
Safety Orientation
SAF022

SAFETY ORIENTATION: A NEW WAY OF THINKING

Whether it’s their first day or their thirtieth year on the job, your employees need to know how to react
quickly in order to help protect themselves and others. Safety Orientation: A New Way Of Thinking focuses
on some of the key work practices that will help your employees work safely.
Help shift and enhance employee attitudes by increasing their safety awareness around personal protective
equipment, chemical safety, fire safety, lockout/tagout, back safety, bloodborne pathogens, and slips,
trips and falls.
Personal Protective Equipment
▸ Hearing Protection
▸ Hand Protection
▸ Body Protection
▸ Head Protection
▸ Foot and Leg Protection
▸ Eye and Face Protection
▸ Respiratory Protection
Bloodborne Pathogens (BBPs)
▸ What are BBPs?
▸ How Infection Occurs
▸ Protection
▸ Decontamination and Exposure
Chemical Safety
▸ Safety Data Sheets
▸ PPE Needed
▸ Storage
Fire Safety
▸ RACE Method
▸ PASS Method for Fire Extinguishers
Back Safety
▸ Proper Way to Life
Slips, Trips and Falls
▸ Prevention

MLHZ01

PAUSE FOR PERFORMANCE: TEN COMMON HAZARDS

Injury statistics show that certain hazards are more common than others in workplaces. Our friends, families
and co-workers are counting on us to be safe. By focusing on these common hazards, you can eliminate
most injuries.
Pause for Performance: Ten Common Hazards microlearning course helps to remind employees of the most
common workplace hazards.
The course covers:
1. Slips, Trips and Falls
2. Vehicle Incidents
3. Lockout/Tagout
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4. Workplace Violence
5. Repetitive Motions
6. Falling Objects
7. Getting Entangled in Machines
8. Breathing Hazards
9. Overexertion
10. Reaction Injuries

COVID-19 Response
EME066

BUSINESS CONTINUITY: OPERATING IN A PANDEMIC

To help organizations maintain safe and productive operations during the COVID-19 pandemic, this program
covers seven key concepts for managing risk and protecting employees. The program reminds organizations to:

▸
▸
▸
▸
▸
▸
▸

Prioritize employees safety and morale
Understand and help mitigate the risks
Anticipate and adapt to the evolving situation
Seize the chance to implement changes in your organization
Assess and adapt to the evolving situation
Think ahead
Leverage digital technology

EME067

BUSINESS RECOVERY: CREATING YOUR RESTART PLAN

Business Recovery: Creating Your Restart Plan describes the key components of a holistic and effective
reopening strategy amidst the COVID-19 pandemic. The program reminds organizations to:

▸
▸
▸
▸
▸
▸
▸

Conduct risk and threat assessments to understand the impact of COVID-19 on their businesses
Consider critical operations in their restart plan
Think holistically
Integrate and be pro-active in training
Validate customer demands
Prepare the supply chain
Ready alternate plans

▸
EME068

THE NEW NORMAL: WORKPLACE SAFETY

What changes in workplace safety should employees expect as they return to work during the COVID-19
pandemic? The New Normal: Workplace Safety helps address key guidelines around personal hygiene, social
distancing, PPE, cleaning and disinfection, and the emergency communication plan. This program will educate
employees and help them to:

▸
▸
▸
▸
▸

Know when, how long, and how often they should wash their hands
Follow social distancing guidelines
Inspect, wear and dispose PPE properly: face masks, respirators, gloves, and eye protection gear
Understand the differences between cleaning and disinfection
Realize the importance of an Emergency Communication Plan
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MLEM01

		

THE NEW NORMAL: BREAKING THE CHAIN OF INFECTION
FOR EMPLOYEES

Work may be resuming, but that doesn’t mean things will return to the way they were. COVID-19 remains a
threat, and The New Normal: Breaking the Chain of Infection discusses how the virus is transmitted, and how
employees can reduce the risk of exposure. The program helps them:

▸
▸
▸
▸
▸

Understand the “ripple effect” of COVID-19
Follow personal hygiene
Practice social distancing
Wear a face mask properly
Clean and disinfect frequently

MLEM02

THE NEW NORMAL: PERSONAL HYGIENE FOR EMPLOYEES

Stress the importance of personal hygiene to help prevent the transmission of COVID-19 with The New Normal:
Personal Hygiene for Employees. This program helps employees

▸
▸
▸
▸
▸

Understand when, how long, and how often hands should be washed
Identify alternatives to soap and water
Use disposable towels, an air dryer, or a touch-free towel dispenser
Reduce touching commonly touched surfaces
Practice frequent hand hygiene and cough etiquette:

MLEM03

THE NEW NORMAL: SOCIAL DISTANCING FOR EMPLOYEES

Learn to practice social distancing and reduce the risk of transmission of COVID-19 with The New Normal:
Social Distancing for Employees. This program helps employees:

▸
▸
▸
▸
▸

Understand how COVID-19 spreads
Appreciate the importance of social distancing
Reduce face-to-face contact
Implement workplace measures to ensure social distancing
Value the importance of wearing a face mask and hand washing

MLEM04

			

THE NEW NORMAL: PERSONAL PROTECTIVE EQUIPMENT
FOR EMPLOYEES

Identify the kinds of PPE that can protect employees from COVID-19 with The New Normal: Personal Protective
Equipment for Employees. This program explains the need to:

▸
▸
▸
▸
▸

Understand how COVID-19 spreads
Appreciate the importance of social distancing
Reduce face-to-face contact
Implement workplace measures to ensure social distancing
Value the importance of wearing a face mask and hand washing
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MLEM05

			

THE NEW NORMAL: CLEANING AND DISINFECTING
FOR EMPLOYEES

Understand the differences between cleaning and disinfection with The New Normal: Cleaning and Disinfecting
for Employees. This program helps employees:

▸
▸
▸
▸

Identify the substances used for cleaning and disinfection
Appreciate the importance of disinfection in reducing the risk of COVID-19
Follow proper cleaning and disinfection procedures
Understand when to conduct “deep cleaning”

MLEM06

THE NEW NORMAL: EMERGENCY COMMUNICATION PLAN
FOR EMPLOYEES

Introduce the components of your COVID-19 plan with The New Normal: Emergency Communication Plan for
Employees. This program identifies:

▸
▸
▸
▸
▸
▸

Where and how employees can be exposed on the job
The steps being taken to protect employees and customers
Updated guidelines from the government
Support services
Procedures for reporting illness or suspected cases of COVID-19
Protocols in case of workplace space

EME069

THE NEW NORMAL: PROTECTING YOUR EMPLOYEES

Many employees are concerned about re-entering workplaces in new normal. You can calm a good deal of
these fears by assuring your team and the community that you’ve put together a thoughtful, comprehensive plan.

▸
▸
▸
▸
▸
▸
▸
▸
▸
▸

Hazard assessment
Controlling hazards and hierarchy of controls
Engineering controls
Administrative controls
PPE
Personal hygiene
Social distancing
Cleaning and disinfecting
Emergency communication plan
Managing employee health

MLEM07

THE NEW NORMAL: BREAKING THE CHAIN OF INFECTION
FOR EMPLOYERS

Is your workplace addressing the threat of COVID-19? Create a COVID-19 Infection Prevention Plan and help
protect your workplace with The New Normal: Breaking the Chain of Infection. The program discusses:

▸
▸
▸
▸
▸

Hazard assessment
Hazard control
Engineering Controls
Administrative Controls
PPE
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THE NEW NORMAL: PERSONAL HYGIENE FOR EMPLOYERS

The New Normal: Personal Hygiene for Employers advises employers that their Infection Prevention Plan must
include ways to promote good personal hygiene at work. The program discusses:

▸
▸
▸
▸
▸
▸

Provision of drying equipment
When, how and how long hands are to be washed
Alternatives to soap and water
Importance of frequent hand washing
Cough and sneezing etiquette and hand hygiene
Proper signage

MLEM09

THE NEW NORMAL: SOCIAL DISTANCING FOR EMPLOYERS

Social distancing is critical for slowing down COVID-19 infections, since the main way it spreads is person to
person. The New Normal: Social Distancing for Employers helps employers design the workplace and modify
processes to maintain physical distance between people. The program advises them on:
▸ Remote work arrangements
▸ Travel policies
▸ Incentives to preclude use of mass transportation
▸ Online platforms
▸ Flexible and staggered shifts
▸ Reorganized work stations/areas
▸ Social distance markers
▸ No-contact policies

MLEM10

THE NEW NORMAL: PERSONAL PROTECTIVE EQUIPMENT
FOR EMPLOYERS

Employers must determine which PPE is appropriate to control an exposure risk to COVID-19. The New Normal:
Personal Protective Equipment for Employers explains how an Infection Control Plan must discuss when and
where PPEs are required, and how they are to be used. The program covers:

▸
▸
▸
▸

Inspection and maintenance
Removal, cleaning and disposal
Types of PPE: face masks, respirators and gloves
OSHA’s Occupational Risk Pyramid

MLEM11

THE NEW NORMAL: CLEANING AND DISINFECTING
FOR EMPLOYERS

Develop cleaning and disinfection procedures and help prevent the spread of COVID-19 at work with The New
Normal: Cleaning and Disinfecting for Employers. Differentiating cleaning and disinfecting, this program discusses schedules, PPE requirements, and role assignments, and it identifies must-clean areas including:

▸
▸
▸
▸

High-traffic areas
Personal desks and work stations
Shared work stations
Common areas and equipment
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MLEM12

THE NEW NORMAL: EMERGENCY COMMUNICATION PLAN
FOR EMPLOYERS

Communicating with employees about what is happening in your community and at your organization during
this uncertain time is a crucial way to show them their health and safety are priorities. The New Normal:
Emergency Communication Plan for Employers identifies the components of the ECP. The program discusses:

▸
▸
▸
▸
▸
▸
▸

Where and how people can be exposed to COVID-19
Safety and health protocols
Employee responsibilities
Updated guidance from government
Sick leave policy
Support services
Reporting and notification procedures

MLEM13

THE NEW NORMAL: MANAGING EMPLOYEE HEALTH

Address employees’ health concerns and help reduce their exposure to COVID-19 with The New Normal:
Managing Employee Health. The program advises employers to:

▸
▸
▸
▸
▸
▸

Monitor employees’ health
Implement a stay-at-home policy for employees with possible COVID-19 symptoms
Include provisions for employees taking care of sick loved ones
Provide flexible sick leave, isolation measures, and privacy concerns
Educate employees on COVID-19 and its symptoms
Explain what employees must do in case of exposure

EMEE64

EMERGING VIRUSES: THE COVID-19 PANDEMIC

Emerging viruses and superbugs are a reality in today’s globalized world. It’s critical to understand what
viruses are, how they are transmitted, and measures we can take — such as social distancing — to help slow the
spread. This microlearning program will help employees:

▸
▸
▸
▸

Understand how new viruses emerge
Differentiate between endemic, epidemic and pandemic
Identify three types of transmissions
Apply preventive, proactive measures

EMEU64

UNIVERSAL PRECAUTIONS AGAINST INFECTION

By understanding how viruses are spread and by taking simple universal precautions, employees can protect
themselves, their colleagues and their families from illness — and from misinformation. This program explains
the chain of infection and helps employees:

▸
▸
▸
▸

Identify agents
Recognize portals of entry and exit
Understand mode of transmission
Follow preventive measures
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FEAR AND ANXIETY: LIVING WITH UNCERTAINTY

While it’s normal to feel anxiety when faced with uncertainty, you can take action to reduce your anxiety
and fear. Help your employees cope and protect their mental health with this new microlearning program. It
explains the need to:

▸
▸
▸
▸
▸
▸

Limit media exposure
Obtain news from reliable sources
Focus on the facts
Control what you can
Practice calming techniques
Take care of yourself

EMEW64

WORKING REMOTELY: STAY PRODUCTIVE AND CONNECTED

Working from home — telecommuting — can yield many benefits, such as more freedom, fewer office
distractions, increased productivity, and less risk of spreading illness. Help employees maximize the
advantages and minimize the disadvantages with this microlearning program. It provides tips
on how to:

▸
▸
▸
▸
▸
▸

Set up a dedicated workspace
Obtain the right tools
Maintain a routine and human connections
Appreciate the importance of breaks
Avoid distractions
Collaborate with fellow workers

Safety Attitudes/Pro-Active Safety
HZR000

HAZARD RECOGNITION FOR UTILITY WORKERS

Awareness is the key to safety. Make sure your utility workers can recognize an incident before it happens.
Show them why accidents occur, how to spot hazards, and how to control hazardous energy, among others.
Accidents
▸ Causes Of Accidents And Safety Precautions
▸ Unsafe Conditions And Acts
Hazard Recognition
▸ Hazard Recognition Techniques
▸ Risk Assessment
Hazard Control
▸ Controlling Hazards
▸ Actions, Consequences, And Teamwork
▸ Responsibility

8
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HAZARD RECOGNITION AND CONTROL

Awareness is the key to safety. Make sure your workers can spot an incident that’s waiting to happen.
This course will help them to recognize workplace hazards and control them before they become accidents.
It examines how to identify unsafe conditions and acts that can lead to accidents. It also illustrates some
scenarios to give employees a chance to put these hazard recognition and control techniques into practice.
Accidents
▸ Causes Of Accidents And Precautions
▸ Unsafe Conditions And Acts
Hazard Recognition
▸ Hazard Recognition Techniques
▸ Risk Assessment
Hazard Control
▸ Hazard Control Techniques
▸ Actions, Consequences And Teamwork
▸ Responsibility

IIP001

EMPLOYEE INVOLVEMENT: THE KEY TO SAFETY

Encourage employees in all industries to take an active role in their safety. This course outlines effective ways
for employees to become involved and explains how both they and their organization can benefit from
their involvement.
Why Should You Be Involved?
▸ Benefits Of Personal Involvement
How Can You Be Involved?
▸ Housekeeping
▸ Safety Inspections
▸ Incident Investigations
▸ Communicate Your Safety Concerns

SAF016

JUST ANOTHER DAY

Shake veteran workers out of their complacency and refresh their awareness of and focus on safety issues.
Follow five long-time employees and watch out for the hazards they miss during a typical work day. Engaging,
interactive and an effective training tool, this course helps renew your workers’ commitment to safety.
Safety For Experienced Workers
▸ The Experienced Worker’s Day
▸ Reviewing The Hazards

9
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HAZARD AWARENESS: READY DAY ONE

This safety readiness program is designed for all levels of employees. It covers important information around
hazard communication, personal protective equipment (PPE), emergency response and worker involvement.
It serves as a good reminder that in order to work safely, employees must plan for safety and be ready for
anything that may occur.
Hazard Communication
▸ Container Labels
▸ Information for Workers
Personal Protective Equipment
▸ PPE Selection and Use
▸ Hazard Protection
Emergency Response
▸ Emergency Actions
▸ Fire Response

SCO002

JOB SAFETY ANALYSIS: PRO-ACTIVE PLANNING

A Job Safety Analysis determines the risks involved in the various operations in a workplace and how these
risks can be avoided with smart planning. This program trains supervisors how to prepare a JSA so they can
spot hazards and resolve them in your workplace.
Effective Leadership
▸ Supervisors And Leaders
Preparing Job Safety Analysis
▸ JSA In A Nutshell
Preparing The JSA Form
▸ Identifying Job Steps
▸ Identifying And Resolving Hazards
Conducting The JSA
▸ Sample JSA Form
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MIRACLE ON THE HUDSON: PREPARE FOR SAFETY

In this course, Captain Chesley “Sully” Sullenberger relives the fateful day that he was forced to land Flight
1549 in the Hudson River. He’ll share how he helped save hundreds of lives by calling upon the 4 C’s –
Competence, Compassion, Commitment and Communication. Your employees will see how they can
acquire and apply these same principles in their own life, both on and off-the-job.
Competence
▸ Sully’s CV
▸ Competence Training Points
Compassion
▸ A Caring Man
▸ Compassion Training Points
Commitment
▸ Dig Deep
▸ Commitment Training Points
Communication
▸ Birds – Whoa!
▸ Communication Training Points

MIRACLE ON THE HUDSON REVISITED:
THE PASSENGERS’ PERSPECTIVE
ATT008

On January 15, 2009 a flight left LaGuardia Airport bound for Charlotte, North Carolina. Less than two minutes
into the flight, Captain Chesley Sullenberger was forced to make an emergency landing in the Hudson
River. Years later, this heroic story still exemplifies the importance of the Four C’s of safety – Competence,
Compassion, Commitment and Communication.
Miracle on the Hudson Revisited: The Passengers’ Perspective includes first-hand accounts of that fateful day
from both Captain Sullenberger and several of the passengers. Through these stories your employees will see
the importance of applying the Four C’s in their own life, both on and off the job.
Competence
▸ Steps for building competence
Compassion
▸ How compassion affects safety
Commitment
▸ Importance of on-the-job commitment for new hires as well as veterans
Communication
▸ The role of effective communication in safety
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SAFETY COURSEWARE
DESCRIPTIONS
MLCM01

PAUSE FOR PERFORMANCE: COMMITMENT

Before doing any task, employees should commit to performing the work safely, efficiently and effectively.
Their commitment will help keep them and everyone around them safe on the job.

▸
▸
▸

What is commitment?
Why is commitment important?
Building commitment

MLCU01

PAUSE FOR PERFORMANCE: COMMUNICATION

Before communicating with others, employees should think about how to express their thoughts and ideas
clearly and accurately. Improving communication and listening skills will help them and everyone around
them to be more productive and safer on the job.

▸
▸
▸
▸

What is communication?
Communication in the workplace
Methods of communication
Improving communication

MLCA01

PAUSE FOR PERFORMANCE: COMPASSION

Encourage your employees to pause before going through their workday and ask how they can be more
compassionate towards the people around you. Teach them how to be more positive, connected and
effective on the job with this course.

▸
▸
▸

What is compassion?
Compassion in the workplace
Increasing compassion

MLCT01

PAUSE FOR PERFORMANCE: COMPETENCE

Encourage employees to pause before doing a task and consider how they could increase their level of
competence moving forward. This course teaches employees that increasing their level of competence will
not only make them more productive, it will also help keep them and everyone around them safe on the job.

▸
▸
▸

Competence
Qualities of competence
Increase your competence

MLME01

PAUSE FOR PERFORMANCE: MIND’S EYE

Keep employees aware of the risks of every task they perform. Introduce them to the “mind’s eye” and enhance
their hazard recognition and assessment competencies.

▸
▸

Mind’s eye
Envision task

MLAB01

PAUSE FOR PERFORMANCE: TOTAL OBSERVATION

Introduce employees to the total observation technique, which helps them reduce the risk of hazards in their
daily tasks, and make the safest decisions.

▸
▸

Hazards around us
Total observation technique
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Take Two...For Safety: A New T.A.K.E.
The effects of a workplace incident can last a lifetime. If you are injured, the quality of your life can be seriously
affected. If you’re killed, your family will never be the same. And if you cause someone else to be injured
or killed, you will have to carry that weight on your shoulders for the rest of your life. The best way to help
prevent a workplace incident is to make safety a top priority. How do we refocus our minds on safety? We
need to Take Two.
Take Two means taking two minutes to think through a job before you start it, so you can make sure you work
as safely as possible. Before you begin any task, take two minutes to:
T = Think
A = Ask
K = Know
E = Execute

▸
▸
▸
▸
▸
▸
▸
▸
▸
▸

Introduction
Arc Flash
Back Safety
Bloodborne Pathogens
Chemical Handling
Confined Space
Driving
Electrical Safety
Emergency Evacuation
Ergonomics

▸
▸
▸
▸
▸
▸
▸
▸
▸

Fall Protection
Fire Safety
Forklift Safety
Hand Safety
Harassment in the
Workplace
Hazard Communication
Hazard Recognition
Hearing Protection
Heat Stress

▸
▸
▸
▸
▸
▸
▸
▸
▸

Lockout/Tagout
Machine Guarding
Personal Protective
Equipment
Safety Orientation
Slips, Trips and Falls
Sprains and Strains
Stairways and Ladders
Travel Safety
Welding Safety
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Hazardous Substances
Hazardous Materials
HAZ025

SAFETY MATTERS: COMBUSTIBLE DUST

Many employees do not realize the dangers of combustible dust, which can, under certain conditions, lead to
a deadly fire or explosion.
Alert employees to these hazards and help prevent dust explosions with Safety Matters: Combustible Dust.
Citing examples and applications of combustible dust, the program helps them:

▸
▸
▸
▸
▸

Identify where combustible dust can be found
Understand and prevent dust explosions
Recognize the value of hazard assessments
Adopt preventive and control measures
Complete training requirements

MLCB01

PAUSE FOR PERFORMANCE: COMBUSTIBLE DUST

It may be common to see dust at your facility, but under certain conditions, some types of dust can lead to a
deadly fire or explosion. Raise awareness and help prevent such explosions with this program.
It helps employees:

▸
▸
▸
▸

Identify uses and examples of combustible dust
Understand how and why fires or explosions can happen
Appreciate the value of hazard assessment
Recognize preventive measures, from engineering controls to safe work practices

COM004

SAFETY MATTERS: COMPRESSED GAS CYLINDERS

Pressurized gases are used in so many ways that people take them for granted - to their detriment. Useful
they may be, but they are dangerous if handled improperly. Ease the pressure with this program, which
covers details on safe and proper handling.

▸
▸
▸
▸

Classifications and labeling
Flammable, non-flammable and toxic gases
Handling cylinders
Valves

COM002

COMPRESSED GAS SAFETY AWARENESS

Give your employees the tools they need to help them identify and handle these types of gases safely
and effectively. This course will introduce them to the classification and labeling system as well as the use,
transport and storage of gas cylinders.
Classifications Of Compressed Gas
▸ Classification And Labeling
▸ Flammable And Nonflammable Gases
▸ Types Of Gases
Guidelines To Use Compressed Gas Cylinders
▸ Using Gas Cylinders
▸ Preventing Gas Leaks
▸ Transporting And Storing Cylinders
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DRM002

SAFETY MATTERS: DRUM HANDLING

Improper drum handling can cause serious injuries and expose a facility and the environment to hazardous
chemicals if the contents are spilled.
Helping you manage these risks, Safety Matters: Drum Handling helps employees recognize different drum
types; label, inspect, handle, and store drums; and follow procedures if there’s a small spill or leak.

▸
▸
▸
▸
▸
▸

Recognize the uses of metal, plastic, and fiberboard drums
Identify the purposes of open or closed tops
Understand labels and markings
Follow DOT and OSHA requirements
Abide by safety practices
Use the six-step response for small spillage

DRM000

DRUM HANDLING

Get this comprehensive safety course and train your employees on the dos and don’ts of drum handling. This
course surveys drum safety practices, covering SOPs, SDS, sampling methods, drum opening procedures,
and air monitoring methods. It examines basic drum types, their specs and their corresponding hazards. It
discusses spill management and prevention, along with chiming procedures, drum-moving equipment, staging
measures, disposal and decontamination practices.
Safety Procedures and Preparations
▸ SOP And Preparation
▸ SDS And Site-Specific Plan
Drum Contents Identification
▸ Identification
▸ Opening And Sampling Drums
Safe Drum Handling
▸ Spill Containment Plan
▸ Moving Safely and in Stages

RAD001

RADIATION SAFETY: THE BASICS

Radiation exposure – direct or indirect – can cause lesions, tumors, cancer and even death. Help shield your
employees from these dangers with the information presented in this course.
Radiation Basics And Biological Effects
▸ Different Types Of Radiation
▸ Biological Effects Of Radiation
Dosage And Dosage Control
▸ Dosage
▸ Dosage Control
Monitoring Exposure
▸ Types Of Survey Meters
Safe Work Practices And Emergency Procedures
▸ Restricted Areas And Safe Work Practices
▸ Emergency Procedures
15
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SSL001

SAFETY MATTERS: SMALL SPILLS AND LEAKS

Discuss the six steps for responding to a small spill or leak. The program covers the dos and don’ts for each
step, Safety Data Sheets, and PPE.

▸
▸
▸
▸
▸
▸

Evaluate the Situation
Notify a Supervisor
Secure the Area
Control and Contain the Spill
Clean Up
Decontaminate Equipment and Personnel

MLSS01

PAUSE FOR PERFORMANCE: SMALL SPILLS AND LEAKS

Discuss the six steps in handling small spills and leaks with this program. Helping employees develop a proactive mindset, it covers:

▸
▸
▸
▸
▸
▸

Evaluating the situation
Notifying a supervisor
Securing the Area
Control and contain the spill
Cleaning up
Decontamination of equipment and personnel

SSL000

SMALL SPILLS AND LEAKS

Leaks and spills in the workplace can be the first step on the road to a disaster for you, your workers and
possibly the surrounding community. Use this course to make sure your employees know what to do in the
event of a leak or spill. It covers the six steps that must be taken when dealing with a spill. Small Spills
And Leaks will remind your workers to take the proper precautions when dealing with a spill of a
hazardous substance. This course delves into supervisor notification, security, PPE and cleanup/
decontamination procedures.
Evaluate The Situation
▸ Assess The Area
▸ SDS
Response To A Spill
▸ Notify A Supervisor
▸ Secure The Work Area
▸ Personal Protective Equipment
Control And Containment
▸ Control The Spill
▸ Contain The Spill
Cleanup And Decontamination
▸ Cleanup
▸ Disposal And Decontamination
Review
▸ Six Steps To Handle A Spill
16
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ASB010

ASBESTOS: DO NOT DISTURB

Asbestos can be found in thousands of homes and workplaces across the country. In general, asbestoscontaining materials can be safe to work around as long as the materials are in good condition and are not
disturbed. However, when asbestos-containing materials are disturbed or become damaged, they can be a
serious health hazard. Exposure can lead to asbestosis, mesothelioma, lung cancer, and other
medical problems.
Asbestos: Do Not Disturb discusses potential health problems, describes how one can be exposed to asbestos,
how to prevent exposure, and what to do if you think asbestos has been released into the air.
Health Effects of Asbestos Exposure
▸ Asbestosis
▸ Mesothelioma
▸ Lung cancer
How Asbestos Exposures Occur
▸ Definition of Asbestos-Containing Material (ACM)
▸ Definition of Presumed Asbestos-Containing Material (PACM)
▸ Jobs prone to asbestos exposure
Preventing Exposure
▸ Where can asbestos be found in buildings
▸ Sign and label recognition
Asbestos-Containing Materials
▸ Definition of friable
▸ Definition of non-friable
▸ Importance of not disturbing ACM
Responding to a Release
▸ Steps to take in the event of a release

HYD002

Hydrogen Sulfide: Detect And Defend

Hydrogen sulfide is a leading cause of inhalation-related deaths in the workplace. It’s toxic, flammable, and
can even be explosive. It often cannot be detected with your senses alone. If your employees are at risk of
exposure and don’t know how to protect themselves, hydrogen sulfide can be a dangerous killer.
Hydrogen Sulfide: Detect and Defend identifies the dangers of hydrogen sulfide and shows employees how to
defend themselves against the hazards of exposure. The course describes how hydrogen sulfide is produced,
its chemical properties and how to respond to its health and safety hazards. Hazard prevention strategies are
identified and finally, the course shows how to avoid exposure by using personal protective equipment.
Production
▸ Production of Hydrogen Sulfide
Properties and Labeling
▸ Physical and Chemical Properties
Health and Safety Hazards
▸ Health Hazards and First Aid

17
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Hazard Prevention Strategies
▸ Safe Work Permits
▸ General Safe Work Practices
▸ Air Monitoring
Personal Protective Equipment (PPE)
▸ PPE Controls

BEN000

BENZENE: KNOWLEDGE IS POWER AND SAFETY

Learn must-know information on preventing benzene hazards. This course helps your organization comply with
OSHA 29 CFR 1910.1028 and explains what benzene is, its properties, PELs, and its exposure symptoms such
as leukemia and reproductive disorders. The program surveys a comprehensive prevention scheme, covering
engineering controls, enclosure, containment, evaporation limits, pumping and HAZCOM.
Benzene And Its Health Effects
▸ What Is Benzene And Who Is Affected?
▸ How Benzene Affects Your Health
Working Safety Around Benzene
▸ Working With Benzene
▸ Personal Protective Equipment
▸ Accidental Exposure

HAZ016

HEXAVALENT CHROMIUM AWARENESS

OSHA has revised its standard concerning permissible exposure limits for HexChrom. Make sure your
workplace is up to date and your workers are aware of the risks of exposure to, and health hazards associated
with, HexChrom. Protect your employees from lung cancer, permanent eye damage and skin ulcerations with
this course.
HexChrom Basics
▸ Hexavalent Chromium Basics
▸ Health Effects Of HexChrom
Safety Guidelines
▸ The New Regulations
▸ Other Steps Towards Safety
▸ Proper Housekeeping
▸ Medical Surveillance And Recordkeeping
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HAZWOPER FIRST RESPONDER: AWARENESS LEVEL

Don’t be caught unaware when HAZMAT incidents occur! Get a comprehensive HAZWOPER overview with
this course, which outlines the five levels of emergency response and cites what responders at the first stage –
awareness – must know and do. It explains how to recognize and identify hazardous substances, delineates the
Emergency Response Plan and shows how to tap additional resources to accomplish the job.
HAZWOPER
▸ What Is HAZWOPER?
▸ HAZWOPER Levels
▸ First Responder – Awareness Level
Hazardous Substances
▸ Hazardous Substances And Their Risks
▸ Recognizing Hazardous Substances
Identifying And Responding
▸ Gather Information
▸ Color Codes And Information Resources
▸ Reporting Spills And Leaks

HAZ023

HAZMAT AWARENESS

HazMat Awareness covers Hazardous Materials Regulations with a focus on the proper handling, packaging,
marking, labeling, placarding, and transport of the hazardous materials.
Hazard Classification
▸ Classes of Hazards
HazMat Packaging
▸ Packaging Regulations
HazMat Marking
▸ Correct Marking on Packages
HazMat Labeling
▸ Labels on Shipped Containers
HazMat Placards
▸ Requirements for Placarding
HazMat Shipping Papers
▸ Shipping Paper Information
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HAZMAT SHIPPING PAPERS

Be sure all supervisors and employees understand the DOT regulations H.M. 181 and H.M. 126F. This course
discusses how to ensure safe transportation of hazardous materials shipments. The program covers general
requirements on how to read and complete shipping papers, including the proper sequence of a typical
shipping paper. It also covers exceptions to the rules and additional requirements for various modes of
transportation, such as special entries.
Filling Out Shipping Papers
▸ Filling Out Regulated And Additional Sections

SIL000

SILICA SAFETY

Keep your employees safe from this useful but deadly material. Train them on safety procedures with this
course, which defines silicosis, explores the sources and effects of exposure, and outlines air monitoring,
medical precautions, engineering controls and safe work practices. When employees work with silica,
knowledge is their best protection.
Silica
▸ What Silica Is And How You Are Exposed
▸ Hazard Identification And Monitoring For Silica
Silica Exposure
▸ Controlling Exposure
▸ Personal Safety And Responsibilities

SUL001

SULFURIC ACID: SAFE HANDLING

When not handled properly, this reactive substance can mean trouble for your employees. This course will
show your employees how to work safely around this hazardous mineral acid.
Working Around Sulfuric Acid
▸ Properties And Hazards
▸ Personal Protective Equipment
▸ PPE Inspection And Maintenance
Safety Practices
▸ Emergency Exposure Response
▸ Working Around Storage Tanks
▸ Handling Leaks And Spills
Safe Unloading Procedures
▸ Pump And Pressure Unloading
▸ Tank Truck Unloading
▸ Rail Car Unloading
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DECONTAMINATION: A MATTER OF LIFE!

Help reduce the damage your employees face after exposure to hazardous substances and environments. In
this course, they will learn the methods, preparations and procedures for decontamination.
Decon Of Personnel
▸ Decon Methods
▸ Decon Preparation
▸ Decon Procedure
▸ Decon Termination And Emergency Decon

Hazard Communication
HAZ024

HAZCOM: ARE YOU GHS-READY?

Chemicals make our lives better in many ways, but they can also threaten our lives if they aren’t treated with
caution. The Occupational Safety and Health Association’s (OSHA) HazCom standard exists to help protect
those who work around chemicals.
HazCom: Are You GHS-Ready? will help your employees understand OSHA’s revised HazCom Standard
including the proper labeling and safe handling of chemicals and how to access important information
on Safety Data Sheets.
Classes of Hazards
▸ Six Classes of Hazards
Labels
▸ Hazardous Signs on Labels
Pictograms
▸ Nine Pictograms
Safety Data Sheets (SDS
▸ 16 Sections of SDS
MLHG01

PAUSE FOR PERFORMANCE: GHS

Introduce your employees to the basics of GHS, from pictographs and labels to hazards, safety practices, and
safety data sheets.

▸
▸
▸
▸
▸

What is GHS?
Why do we use GHS?
Hazard classification
GHS pictographs and labels
Safety Data Sheets

MLLB01

PAUSE FOR PERFORMANCE: HAZCOM LABELS

Help employees identify the labels and product identifiers for hazardous chemical containers. Providing
compliance guidance for the HazCom Standard, this program covers:

▸
▸
▸
▸
▸
▸

Signal word
Hazard statement
Pictograms
Precautionary statements
Contact information
Supplementary information
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PAUSE FOR PERFORMANCE: PICTOGRAMS

Show employees a list of pictograms as part of your HazCom training. This program briefly describes the nine
types and what each signifies.

▸
▸
▸
▸
▸
▸
▸
▸
▸

Health Hazard
Flame
Exclamation Mark
Gas Cylinder
Corrosion
Exploding Bomb
Flame Over Circle
Skull and Crossbones
Environment

MLHS01

PAUSE FOR PERFORMANCE: SAFETY DATA SHEETS

Acquaint employees with Safety Data Sheets and help them identify and work with chemicals safely.

▸
▸
▸

Safety Data Sheets (SDS)
Comprehensive information
Three important questions

SDS001

SAFETY DATA SHEETS

Guessing the safest way to work with or around a chemical can be very dangerous. If you don’t know how
to handle a substance properly, you could end up with chemical burns, breathing problems, fires or even
explosions. Instead of guessing, employees should use the Safety Data Sheet, or SDS.
Safety Data Sheets: The Information Connection covers each of the sixteen sections of the standardized SDS
and how to obtain the pertinent information employees need when they need it.
Safety Data Sheet Basics
▸ What You Need To Know
Using Safety Data Sheets
▸ Sixteen Section Format
▸ Chemical Identification and Hazards (Sections 1, 2, and 16)
▸ Ingredients and Exposure Guidelines (Sections 3, 8, and 11)
▸ Emergency Response (Sections 4, 5, and 6)
▸ Handling and Storage (Sections 7, 9, and 10)
▸ Environmental and Regulations (Sections 12 through 15)
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SAFETY MATTERS: LAB SAFETY

Share with employees the steps to minimize the risk of injury in a lab and clue them in on the hazards they
may face.
Chemical Hygiene Plan
▸ Major elements of a plan
▸ Breakdown of plan sections
Chemical Hazards
▸ Definitions of different hazards
Safety Data Sheets
▸ Employer responsibilities
▸ Employee responsibilities
Administrative and Engineering Controls
▸ Examples of administrative controls
▸ Examples of engineering controls
Safe Work Practices and PPE Controls
▸ Examples of other safe work practices
▸ Overview of personal protective equipment (PPE)
Handling an Emergency
▸ Contents of an emergency plan

CHE009

CHEMICAL SAFETY: A FORMULA FOR SUCCESS

If your employees work with or near chemicals, they may already be familiar with the hazards and potential
consequences of an exposure. There are acute and immediate effects, such as acid burns or long-term and
chronic effects, such as liver and kidney disease, or cancer. No matter the effect, chemical exposures can be
life-threatening.
Chemicals can also cause fires and explosions, corrode equipment, and cause environmental problems.
Chemical Safety: A Formula For Success helps your employees understand the importance of working
safely around chemicals by discussing the hazard categories of chemicals, the components of Hazard
Communication, proper handling and storage techniques, and procedures for handling chemical emergencies.
Chemical Hazard Identification
▸ Toxic, Flammable and Combustible, Corrosive, and Reactive
▸ Hazard Communication
Chemical Storage and Handling
▸ Chemical Handling
▸ Chemical Storage
Chemical Emergency Response
▸ Emergency Preparedness
▸ Spill Response
▸ Portable Fire Extinguisher Use
▸ Chemical First Aid
23

SAFETY COURSEWARE
DESCRIPTIONS
Operating Hazardous Equipment
Forklift/Crane Safety
CRA007

SAFETY MATTERS: CRANE INSPECTION

Show employees how to conduct and/prepare for daily, monthly, or annual inspections. Covers roles and
responsibilities, post-inspection, logs, and corrective measures.

▸
▸
▸
▸
▸
▸
▸

Identify components and areas to check
Prepare for the monthly or annual inspections
Understand the roles and responsibilities of owners and operators during inspections
Follow post-inspection procedures, including in cases of failure
Use the inspection log
Adapt corrective measures
Recognize the need for load tests

MLCR01

PAUSE FOR PERFORMANCE: CRANE INSPECTIONS

Show employees “especially operators” how to conduct crane inspections with Pause for Performance: Crane
Inspections. Outlining safety practices, the program covers the following:

▸
▸
▸

Areas and parts to check during visual inspections
Components to test during operational inspections
Post-inspection procedures.

CRA003

CRANE INSPECTION

From welds, seams, hooks and boom to sheaves, mainframe, rigging and hoses, this course surveys the parts
that employees must focus on to ensure crane safety. It cites the dos and don’ts for every part and type of
inspection: daily, monthly and annual. It explains what employees can expect and lists what they can do in case
of a failed inspection. Make sure that your crane is up to scratch with course, comply with OSHA standards and
prevent the unthinkable!
Daily Inspection
▸ Daily Inspection Process
Monthly Inspection
▸ Monthly Inspection Process
Annual Inspection
▸ Annual Inspection Process
Results
▸ Inspection And Correction
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SAFETY MATTERS: INDOOR CRANES

Help protect employees from the hazards of crane work. The program shows the dos and don’ts of
inspections, testing, rigging, and operations.

▸
▸
▸
▸
▸
▸
▸

Recognize the common types of indoor cranes
Identify the components to check in a visual pre-inspection
Know what buttons to test in the operational pre-inspection
Perform a crane testing
Determine the load’s weight
Select the proper rigging
Secure, lift, and move loads safely

RIG001

RIGGING: EQUIPMENT BASICS

Hook up with this course now and learn the basics of rigging: equipment ratings, slings, hitches, wire ropes,
web slings, rigging process, and attachments like shackles and eyebolts. The course takes your employees
through rigging procedures, offering handy safety advice every step of the way.
Introduction To Rigging
▸ Rigging Basics
▸ Rigging Equipment
▸ The Rigging Process
Wire Ropes
▸ Wire Rope Basics
▸ Wire Rope Design And Construction
▸ Wire Rope Splices And End Fittings
Webbing
▸ Synthetic Web Slings
Connectors And Attachments
▸ Types Of Attachments
▸ Hooks And Shackles
▸ Eyebolts And Turnbuckles

RIG002

RIGGING OPERATIONS

If you’re at a loss how to plan your rigging operations, then this course is for you. It’s a step-by-step guide that
examines the ins and outs of the process. Train your workers on equipment requirements, load characteristics
and environmental factors. Ensure that they follow inspection procedures and heed safety advice on load
lifting and equipment maintenance. This course also discusses the rigging plan, equipment requirements,
environmental factors and safe lift preparation.
Planning The Lift
▸ The Rigging Plan
▸ Load Characteristics
▸ Equipment Requirements
▸ Environmental Factors
Inspection
▸ Inspection Requirements
▸ Inspecting Wire Rope
▸ Inspecting Synthetic Webbing
▸ Inspecting Hardware Attachments
▸ Inspecting Assembled Rigging
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Performing The Lift
▸ Lift Preparation
▸ Lifting The Load
▸ Lift Safety
Gear Maintenance And Storage
▸ Sling Care And Use
▸ Wire Rope And Synthetic Webbing

MLRI01

PAUSE FOR PERFORMANCE: RIGGING

Cranes help us accomplish impressive lifting feats. However, without the proper rigging, these lifts would
neither be possible nor safe. Pause for Performance: Rigging helps employees:

▸
▸
▸
▸

Rig a load properly
Determine the load’s weight and crane’s lifting capacity
Work with the SWL and select the right rigging
Inspect equipment for damage or missing components

AER002

SCISSOR AND BOOM LIFT SAFETY

Train lift operators and help protect employees. The program tackles hazards, pre-operation inspections, work
zone safety, and operational dos and don’ts.
Training
▸ Importance of training
▸ What training should cover
▸ When refresher training is needed
Hazards
▸ Common hazards
Pre-Operation
▸ Inspections
▸ Work zone safety & conditions
General Safety Precautions
▸ Safe work practices
▸ Scissor Lifts
Characteristics
▸ Safety
Boom Lifts
▸ Characteristics
▸ Safety
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AERIAL LIFTS

Raise safety awareness with this course. It trains workers on the ins and outs of aerial lift operation: types,
design, hazards, maintenance and safety. The program examines the visual inspection process, the physics of
stability, the role of gravity, and the use of outriggers, stabilizers and extendable axles.
Aerial Lifts
▸ Types And Components
▸ Safety Components
Pre-operation Requirements
▸ Permits
▸ Pre-Operation Procedures
Operation
▸ Stability And Concentration
▸ Safe Work Practices

BUC000

BUCKET TRUCKS: EXTENDING YOUR SAFETY

Raise your employees’ bucket safety awareness with this course. It trains them on precautions and
maintenance-inspection guidelines, proper outfit, pre-planning strategies and fall arrest equipment inspection
for safe bucket operation.
About Bucket Trucks
▸ Basics, Operator Training And Inspection
Bucket Truck Maintenance
▸ Work Clothes, PPE And Pre-planning
▸ Working Around Electricity

FRK016

FORKLIFTS: UNDERSTANDING THE RISKS

Forklifts are useful pieces of equipment found in many workplaces, but without the knowledge to use them
properly they can also be some of the most dangerous. Whether a worker is operating the vehicle, or simply
in the wrong place at the wrong time, forklift incidents can cause serious harm. Every year forklifts cause an
estimated 35,000 serious injuries and almost 100 deaths.
Forklifts: Understanding The Risks describes the common hazards of operating forklifts. It reviews the
importance of understanding how to correctly operate forklifts, factors that can lead to incidents, and the
importance of inspecting vehicles before and during operation.
Common Hazards of Forklift Operations
▸ Common Work Environmental Hazards
▸ Common Operational Hazards
Forklift Basics
▸ Forklift Handling
Forklift Controls
▸ Basic Controls
Forklift Instrumentation
▸ Instrument Panel
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Inspecting Your Forklift
▸ Pre-Operational Inspection
▸ Operational Inspection
Safe Operation
▸ Operating a Forklift Safely
Safe Maneuvering
▸ Properly Maneuvering a Forklift

MLFS02

			

PAUSE FOR PERFORMANCE: FORKLIFT CONTROLS
AND INSTRUMENTS

Get a two-minute walkthrough of the controls and instruments on a forklift. Describing the functions of each,
this video familiarizes you with the following:

▸
▸
▸
▸
▸
▸
▸
▸

Directional control
Hydraulic lift
Accelerator pedal
Clutch pedal
Inching pedal
Parking break
Various gauges
Hour meter and batter discharge indicator

MLFS03

PAUSE FOR PERFORMANCE: FORKLIFT INSPECTIONS

Know what to look for, and what to do, when inspecting your forklift. This video explains the dos and don’ts for
the pre-operational and operational inspection, as well as routine maintenance.

▸
▸
▸
▸
▸
▸

Pre-Operational Inspection
Leaks, cracks, fluid levels, hoses, and mast chains
Chain tension
Decals and nameplates
Operator manual
Seatbelt, mirrors, and fire extinguisher

MLFS04

PAUSE FOR PERFORMANCE: FORKLIFT SAFE OPERATIONS

Follow the dos and don’ts in forklift operations. Covering various aspects and conditions of driving, this clip
explains how to get on and off the forklift, and discusses:

▸
▸
▸
▸
▸
▸
▸
▸
▸

Speed limits and horns
Braking and acceleration tips
Parking and pedestrian safety
Turning and avoiding bumps or objects
Traveling in reverse
Driving on inclines and wet flooring
Dos and don’ts on loading docks
Moving from daylight into a dark building and vice versa
What to do if the forklift tips over
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FORKLIFT SAFETY

Raise your employees’ forklift know-how and strengthen your OSHA compliance requirements with this course.
It walks your employees through forklift basics, including design, parts, inspection, safety, and operation,
particularly how to park, place, move and set a load down.
Fundamentals
▸ Design
▸ Components And Specifications
▸ Inspection
Operating Basics
▸ Preparation
▸ Avoiding Hazards
▸ Proper Lifting
Moving With A Load
▸ Tall Loads And Dangerous Surfaces
▸ Docks And Ramps
▸ Emergency Situations
Setting The Load Down
▸ Lowering And Placing The Load
▸ Parking

Motor Vehicle Safety
MTV012

BEFORE YOU TURN THE KEY

Brush up on what drivers need to do before they get in a vehicle and turn the key. Remind your employees
of the importance of simple but effective pre-trip checks and the proper way to use standard equipment on
vehicles. See how just a few basic steps may save lives.
Minors, Safety Belts And Airbags
▸ Proper Use Of Mirrors, Safety Belts And Airbags
Preliminary Inspection
▸ The Walk-around And Seat Adjustment
▸ Dashboard, Instrument, Headrest And Buckling Up

MTV013

EMOTIONAL WRECK

Steer your employees to safety with an unsettling look at how aggressive driving can lead to tragedy. Let them
watch in horror as the narrator rides with drivers to manipulate their emotions and spur them to swerve, speed,
tailgate and ignore traffic lights on their way to disaster. Get into your employees’ heads, raise their awareness
and maybe even save their lives with this course!
Aggressive Drivers
▸ Selfish Drivers
▸ Impatient Drivers
▸ Oblivious Drivers
▸ Competitive Drivers
Avoid Being An Aggressive Driver
▸ Prevent Aggressive Driving
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DISTRACTED DRIVING: GAME OVER

Do your employees treat driving like a game? Pushing buttons and playing recklessly as if they can just restart
if something goes wrong? This course provides an eye-opening look at how easily distractions can take over in
the driver’s seat and suggests strategies to avoid this potentially deadly habit.
Driving Distractions
▸ Common Examples
▸ Cell Phone Use
Overcoming Distractions
▸ Risks And Consequences
▸ Solutions You Can Use

MTV025

DISTRACTED DRIVING: REWIND

Sometimes it seems that multitasking is the only way to get everything accomplished in this busy, fast-paced
world. While trying to multitask may seem like a good idea, trying to do two things at once can result in a
second-rate performance. It is imperative that while driving, we stay aware of what we are doing, as well as
what other drivers are doing.
Statistics show that distracted driving is the reason behind many accidents and fatalities. Distracted Driving:
Rewind reviews the common causes of distracted driving and the reasons to drive without distraction. By
learning the myths surrounding multitasking while driving, and performing predriving safety checks, your
employees can avoid mistakes that may cause heartache and pain to their family and others.
What is distracted driving?
▸ Types of Distractions
Safe Vehicle Operation
▸ Before Driving Checklist
▸ City, Highway, and Rural Driving
Distracted Driving Myths
▸ The Reality of Driving
Practices Related to Distracted Driving Prevention
▸ Learn from Past Mistakes

MLDD01

PAUSE FOR PERFORMANCE: DISTRACTED DRIVING

Alert employees to the hazards of distracted driving and help them stay focused behind the wheel. It’s the best
route to keeping them and everyone safe.

▸
▸
▸

What is distracted driving?
Types of distractions
Distracting activities
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DRIVEN TO DISTRACTION II

Take your employees for another ride with the Distraction Demon, who orchestrates another highway tragedy
and shows yet again the importance of focusing behind the wheel. This sequel looks at new distractions – cell
phones, GPS, mp3 players, etc. and illustrates how one second of inattention is the same as driving 88 feet per
second without looking at the road. Use this vivid, hard-hitting approach to combat complacency and drive
home the message: avoid distracted driving!
Driving Distractions
▸ Common Driving Distractions
Driving Mistakes
▸ Making Adjustments
▸ Multi-Tasking
Only A Second!
▸ Pay Attention To The Road

MTV020

GOLF CART & LSV SAFETY: ON AND OFF THE COURSE

Many industries are taking advantage of golf carts and other low-speed vehicles (LSVs) for easy transportation.
This course, produced in conjunction with the National Golf Cart Association, presents basic safety rules for
golf cart operation and offers other common sense operating tips.
Safety Rules
▸ Rules #1-#5
▸ Rules #6-#10
Operating Procedures
▸ Before You Operate The Vehicle
▸ While Operating The Vehicle

MTV026

SAFE DRIVING: TAKE CONTROL

We are all familiar with vehicle accidents, whether we’ve experienced them first hand or been a witness to one.
Certainly, we cannot control all the factors that lead to vehicle crashes, but every time you make a safe choice
while driving, you could be preventing a tragic incident from occurring.
Safe Driving: Take Control provides tips that will help you and your employees drive safely. The program
explains how to prepare the vehicle for safe driving and how to conduct a pre-drive inspection. It describes
how to eliminate distractions and provides tips you can apply to stay safe while driving in challenging
driving conditions.
Prepare to Drive
▸ Survival kit
▸ Pre-drive tasks
▸ Personal adjustment of vehicle
Eliminate Driving Distractions
▸ Tips to avoid distracted driving
Safe Driving Tips
▸ Defensive driving
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Back Up Safely
▸ Tips to follow
Challenging Driving Conditions
▸ Driving at night
▸ Driving in adverse weather
Driving Emergencies
▸ If you break down
▸ If you are involved in a crash

MLWD01

PAUSE FOR PERFORMANCE: WINTER DRIVING

Help employees make the necessary adjustments to different driving conditions in winter. This program covers
vehicle preparation and safe driving practices.

▸
▸
▸

Driving in winter more hazardous
Prepare your vehicle
Driving in winter conditions

Tool/Machine Safety
LAS001

LASER SAFETY: THE BLINK OF AN EYE

Lasers play an innovative role in the workplace today. Their power, precision and versatility make them
ideal for many jobs but it they are mishandled lasers can cause serious injuries. This course will show your
employees how to work safely with lasers, the various industrial and construction uses for lasers, the hazards
they pose and the damage they can do if not used properly.
Laser Safety And Classification
▸ Be Aware Of Standards And Hazards
▸ Classification System
Safe Work Practices
▸ Role Of LSO And Other Personnel
▸ Engineering And Administrative Controls
▸ Eye Safety
▸ Accidents, Other Hazards And Training Program
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SAFETY MATTERS: MACHINE GUARDING

Every year almost twenty thousand people are injured and lose limbs in machine related incidents. Almost a
thousand of them die. The safety of your employees matters.
Safety Matters: Machine Guarding provides a brief overview of the hazards of working with machinery, the
general types of machine safeguards, and how to do the job right to avoid injury, amputation, or even worse.
Mechanical Hazard Locations
▸ Point of operation
▸ Power transmission apparatus
Hazards from Mechanical Motions
▸ Rotating machine parts
▸ In-running nip points
▸ Reciprocating motions
▸ Traversing parts
Hazards from Mechanical Actions
▸ Cutting
▸ Punching operations
▸ Shearing operations and machines that bend
Safeguards when Working with Machines
▸ Purpose of machine guarding
▸ Five types of safeguards
▸ Four types of machine guards
▸ Safety control

MLPI01

PAUSE FOR PERFORMANCE: PINCH POINTS

Show employees where pinch points are most likely to occur, help them plan their work and practice safe
work procedures.

▸
▸
▸

Pinch points
Where pinch points can happen
Protection against pinch points

WEL005

SAFETY MATTERS: WELDING SAFETY

Safety Matters: Welding Safety is designed to increase participants’ knowledge of welding safety. 3
with welding and identifies specific lines of defense for protection against hazards. It also describes how to
wear the appropriate personal protective equipment (PPE) and how to work safely before, during, and after
welding activities.
Hazards of Welding
▸ Health Hazards
▸ Safety Hazards
▸ Lines of Defense
Welding and Personal Safety
▸ Personal Protective Equipment
▸ Work Area Safety
▸ Being Safe When Welding
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POWERED HAND TOOLS: SAFETY IS IN YOUR HANDS

Powered hand tools are used in almost every industry, and for good reason, they get things done. They allow
workers to easily perform tasks that would otherwise be difficult, if not impossible. However, not using tools for
their designated purposes can cause serious injuries including electrocution, hearing loss, eye injuries, or even
the loss of a limb.
Powered Hand Tools: Safety Is In Your Hands will show employees how to protect themselves from powered
hand tools as well as basic tool safety precautions. Powered hand tools are useful, but without the proper
safety precautions they can be a dangerous on the job hazard. That is why it is important to remember that
with powered hand tools, safety is in your employees’ hands.
Basic Protection and Precautions
▸ PPE
▸ Basic Tool Precautions
Tool Power Sources
▸ Electric Tools
▸ Battery Operated Tools
▸ Pneumatic Tools
▸ Power Actuated Tools
Specific Tools
▸ Circular Saws
▸ Drills
▸ Grinders

MLUK01

PAUSE FOR PERFORMANCE: BOX CUTTER SAFETY

This clip stresses the need to inspect the components of box cutters, and explains how to use them handy
tools safely. The clip helps employees:

▸
▸
▸
▸
▸

Wear the proper PPE
Position the hands safely
Perform the safe and proper cutting motion
Know how to cut thick materials
Store and maintain box cutters properly.

Hazardous Environments
CSE014

SAFETY MATTERS: CONFINED SPACE ENTRY

Confined spaces are not just challenging work environments - they also pose a serious threat to safety. It is
important to be aware of the hazards in such spaces and be proactive about containing them.
This course educates employees on confined spaces and how to operate safely within such environments. It
discusses the criteria, characteristics, and key industry statistics of confined spaces. The program explains
the hazards of confined spaces, and how to detect and control them to ensure personal safety. It also
outlines the training, roles and responsibilities of various members of the entry team and what emergency
and rescue planning entails.
Requirements for Confined Space Entry
▸ Requirements for Confined Space Entry
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Hazards and Safety
▸ Hazards in Confined Spaces
▸ Hazard Controls and Detection
Roles and Responsibilities
▸ Training and Entry Team Duties
Rescue
▸ Non-Entry and Rescue Teams

MLCS01

PAUSE FOR PERFORMANCE: CONFINED SPACES

Help employees to take heed before working in or around confined spaces and make sure they have all the
necessary training and equipment to do the work safely. Their safety is always the number one priority.

▸
▸
▸

What is a confined space?
Permit-required confined space
Entry team members and training

TRE006

TRENCHING AND SHORING SAFETY

Help employees distinguish the differences and hazards of trench and excavations; soil classifications;
protective systems; safe practices, and emergency response.
Trench vs Excavation
▸ The differences between a trench and an excavation
▸ Hazards of each
Soil Classifications
▸ Categories of soil
▸ Responsibilities of a competent person
Protective Systems
▸ Selecting the correct systems
Safe Work Practices
▸ Inspections and testing
▸ Site preparedness
CSE003

CONFINED SPACE ATMOSPHERIC TESTING

A hazardous and potentially deadly atmosphere is a risk that exists every time your employees enter a
confined space. Atmospheric testing can be one of the best lines of defense against this dangerous working
condition. This course will help educate your employees on the basics and importance of proper atmospheric
testing techniques for confined spaces.
Confined Space Atmospheric Hazards
▸ Identifying, Testing, And Instrument Calibration
Testing Confined Spaces
▸ Pre-entry Testing
▸ Oxygen Levels, Flammable Gases, And Toxic Vapors
▸ Monitoring And Responding
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CONFINED SPACE VENTILATION

Special safety precautions required for confined space ventilation are reviewed in this course. It discusses
the common atmospheric hazards found in confined spaces and explains special techniques used to ventilate
various confined spaces.
Atmospheric Hazards and Testing
▸ Purpose of Atmospheric Testing
Confined Space Ventilation
▸ Types of Mechanical Ventilation
▸ Ventilation Troubleshooting
Tips and Techniques
▸ Effective and Safe Ventilation

CSE013

CONFINED SPACE ENTRY: PLAN AND PREPARE

Show your employees why it is vital to follow procedure when working in a confined space. Every year,
numerous injuries and fatalities occur in confined spaces and often, these spaces seem safe or even harmless
– but looks can be deceiving. This course will help your employees understand what a confined space is, the
hazards associated with it and the steps to follow to maintain a safe work environment.
Confined Space Entry
▸ Identifying Confined Spaces and Their Hazards
▸ Confined Space Entry Permits
Confined Space Hazard Controls
▸ Managing and Controlling the Hazards
The Entry Team
▸ Roles and Duties of the Entry Team

HAZARDOUS ENERGY
ELECTRICAL SAFETY
ELE020

SAFETY MATTERS: ARC FLASH

Protect employees and help them understand the causes of arc flash, training and regulations, safe work
practices, boundaries, hazard risk category levels, incident energy analysis, and PPE requirements.
Safety Matters: Arc Flash also helps your employees understand
▸ Incident Energy Analysis
▸ Energized Electrical Work Permit
▸ Hazard Risk Category Levels and PPE for each
▸ Protective Boundaries and their differences from each other
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ARC FLASH: LIVE TO TELL

In the extreme temperatures of an arc flash blast metal vaporizes. The sound can reach 160 decibels causing
permanent severe hearing damage. This program will bring you and your workers up to speed on the 2009
version of the NFPA70E. Get information on arc flash prevention, achieving an electrically safe work condition,
qualified and unqualified persons, job planning and hazard analysis.
Arc Flash
▸ Arc Flash Hazards
Safety Precautions And Guidelines
▸ Standards And Trained Personnel
▸ Job Planning And Hazard Analysis
▸ PPE, Proper Tools, And Protective Boundaries

ELE019

SAFETY MATTERS: ELECTRICAL SAFETY

Show your employees how to keep themselves safe when working with electricity.
Introduction to Electricity
▸ Definition of conductors
▸ Definition of insulators
▸ Different forms of currents
Circuits
▸ Importance of grounding devices
▸ Two-prong vs three-prong plugs
Circuit Protection Devices
▸ Protecting equipment with fuses and circuit breakers
▸ Protecting people with a ground fault circuit interrupter (GFCI)
Safe Work Practices
▸ Proper dress including personal protective equipment (PPE)
▸ Situational awareness
▸ Lockout/Tagout
▸ Tools and equipment to use

ELE004

ELECTRICAL POWER GENERATION

Get comprehensive electrical safety training and unplug the dangerous currents with this course. It discusses
how the OSHA standard can help save workers’ lives, examining sites where they work on electrical energy and
exploring the associated hazards. It provides safety procedures for various electrical tasks, explains how to use
different tools and equipment and cites grounding measures to ensure your employees’ safety.
Fundamentals
▸ Training and Job Briefings
▸ Personal Protective Equipment
Working with Equipment
▸ Power Tools, Generators and Live-line Tools
▸ Mechanical Equipment
▸ Ladders, Platforms and Fall Protection
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Common Hazards
▸ Crane
▸ Excavations
▸ Lockout/Tagout
▸ Enclosed and Permit Spaces
Job Specific Hazards
▸ Exposed Energized Parts
▸ Overhead Lines
▸ Underground Electrical Installations

MLES01

PAUSE FOR PERFORMANCE: ELECTRICAL SAFETY

Educate employees on the hazards posed by electrical equipment. Show them that while electricity is
extremely useful, they have to know how to avoid electrical risks and keep themselves and everyone safe.

▸
▸
▸

Electrical hazards
Hazards of electricity
Electrical safety

MLFD02

PAUSE FOR PERFORMANCE: ELECTRICAL SHOCK

This course shows you the basics of handling electrical injuries. It defines electrical shock and helps employees:

▸
▸
▸

Identify injuries arising from electrocution
Know what (not) to do when responding to cases of electrocution, from switching off the current to
removing the victim away from the electrical source
Recognize the conditions that need professional help.

ELE017

ELECTRICAL CASE HISTORY

Because of complacency around electricity, on average, one worker is electrocuted every single day of every
year! This course takes a look at the details of a real-life tragedy to help your employees understand the
dangers of this powerful force and what steps they can take to work safely around it.
Electrical Case History
▸ Dangers of Electricity
Lessons Learned
▸ Lockout/Tagout
▸ Scissor Lift Operation

ELE012

ELECTRICAL SAFETY FOR THE QUALIFIED WORKER

Give your qualified workers’ know-how a big surge and ensure that their skills are more than up to scratch.
This course covers the nature of electrical accidents and explains how electricity harms the body. It then cites
critical dos and don’ts for testing, installation, grounding, insulation, guarding, overcurrent protection and
GFCIs. The course examines safe practices concerning flash hazard analysis, flash protection boundaries, arc
flash and flash potential. It helps you comply with electrical codes and regulations, explains the nature of the
electrical safety program and explores the stringent criteria for PPE use.
Effects Of Electrical Safety
▸ How Does Electricity Affect The Body?
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Electrical Safety Measures
▸ Working Safely Around Electricity
▸ Test Equipment
▸ Protective Measures
▸ Codes And Regulations
▸ Protective Equipment
▸ Electrical Safety Program

Lockout/Tagout
LOT012

SAFETY MATTERS: LOCKOUT/TAGOUT

This course fosters awareness of the sources of energy we work with, the dangers of those energies, and the
systems in place to prevent potential issues. It also covers the five main causes of preventable injuries and
the 7-step lockout/tagout procedure.

▸
▸
▸
▸
▸

Five Main Causes of Preventable Injuries
Understanding Hazardous Energy
Lockout vs. Tagout
Seven Step Process to LOTO
Employee Instruction and Training

LOT000

LOCKOUT/TAGOUT

Walk your employees through the lockout/tagout process with this online course. Supplementing your OSHA
compliance efforts, the program covers basic concepts and describes the six LOTO procedures step-by-step. It
also discusses lock and tag removal and special LOTO scenarios.
Introduction to Lockout/Tagout
▸ The Importance Of Lockout/Tagout
Basic Concepts
▸ Basic Terms And Characteristics
▸ Applying Lockout/Tagout
▸ Four Es Of Safety: Energy
▸ Four Es Of Safety: Engineering, Education, Enforcement
OSHA’s 6-step Procedure
▸ Introduction To The 6-step Procedure
▸ Lockout/Tagout Steps 1-3
▸ Lockout/Tagout Step 4
▸ Lockout/Tagout Steps 5 And 6
▸ Performing The Work, Then Removal Of Locks And Tags
▸ Special Situations
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Food Safety

FOOD01

FOOD SAFETY: INTRODUCTION

Food safety is made up of important steps taken to prevent foodborne illness. Foodborne Safety: Introduction
discusses some of these processes including the role of the regulatory and advisory agencies for food in North
America and risks to food safety in a food processing facility.
Food Safety
▸ Food Safety Matters
Regulatory Agencies for Food
▸ Ensuring a Safe Food Supply
Preventing Foodborne Illnesses and Outbreaks
▸ Risks Contributing to Foodborne Illness and Outbreaks

FOOD02

FOOD SAFETY: HACCP

Hazard Analysis Critical Control Points (HACCP) was originally established to make sure that astronauts did
not develop any foodborne illnesses while in space. Today, this program is still being used as an effective
means to prevent food hazards from occurring. This course discusses the types of facilities that are required to
implement a HACCP plan, the benefits involved and the seven principles of any HACCP plan.
The Purpose of HACCP
▸ Why HACCP?
Seven Principles and the Employee’s Role
▸ The Seven Principles of HACCP

FOOD03

FOOD SAFETY: CLEANING AND SANITIZING

Botulism, Salmonella, Listeria and E. coli are just some of the pathogens that can wreak havoc and lead to
foodborne illnesses. This course shows your employees why it is vital that they take the time and effort to
clean and sterilize their workspace properly. It also shares cleaning and sanitization practices for both dry
and wet food processing facilities.
Sources of Contamination
▸ Where do Pathogens Grow?
Cleaning and Sanitizing
▸ Cleaning
▸ Sanitizing
▸ GMPs and SSOPs
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FOOD SAFETY: PERSONAL HYGIENE

There are an estimated 75 million cases of foodborne illnesses that occur each year in the United States and
the majority of these are a result of poor personal hygiene. Food Safety: Personal Hygiene will help your
employees understand the procedures put in place and the personal hygiene practices to follow in order
achieve high quality and safe food products.
Risks of Poor Personal Hygiene
▸ Prevent Spreading Illness and Microorganisms
Personal Hygiene Practices
▸ Proper Hand Hygiene
▸ Personal Hygiene
▸ Protective Outer Clothing
Avoiding Cross-Contamination
▸ Prevent Cross-Contamination

FOOD05

FOOD SAFETY: MAINTENANCE AND SANITATION

Each employee has the potential to introduce viruses and pathogens into the food production line, but with
the right procedures in place, employees have the ability to prevent this from happening as well. This course
informs non-food handlers of the Good Manufacturing Practices (GMPs) designed to help them do their part in
delivering high quality and safe food products to customers.
What is a GMP?
▸ Adhering to GMPs and SSOPs in Maintenance and Sanitation
GMPs for Non-Food Handlers
▸ Disease Control and Personal Hygiene
▸ Maintenance Worker GMPs
▸ Sanitation Worker GMPs

FOOD06

FOOD SAFETY: FOODBORNE ILLNESS

Preventing foodborne illness is one of the top priorities of a food handling facility. This course introduces
employees to the three types of hazards that can compromise food safety. It also suggests personal hygiene
tips to follow to help prevent the spread of illness.
Classifying Hazards
▸ Preventing Biological, Chemical and Physical Hazards
Personal Hygiene
▸ Keeping Hazards Out of Food
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FOOD SAFETY: DANGEROUS MICROORGANISMS

Bacteria, viruses, parasites and toxins can all cause foodborne illness. Share important information on these
bugs including distinguishing characteristics so employees know what to watch for in the foods they handle.
Bacteria
▸ Understanding Bacteria
Viruses
▸ Understanding Viruses
Parasites
▸ Understanding Parasites
Toxins
▸ Understanding Toxins

FOOD08

FOOD SAFETY: ALLERGEN CONTROL

Food allergies can lead to emergency room visits, and sadly, sometimes even death. This course discusses
major allergens recognized in the U.S. and Canada. It also outlines ways to avoid cross-contact and how to
use an Allergen Control Plan.
Major Food Allergens
▸ The Big Eight plus Four
Prevent Allergen Cross-Contact
▸ Following an Allergen Control Plan

FOOD09

FOOD SAFETY: ENSURING QUALITY

A company’s reputation rests on the quality and safety of its food products. This course looks at why quality
is important and how quality is measured. It covers how Quality Control and Assurance is used to ensure
the production of safe foods and the role that each individual employee has in creating these foods on a
consistent basis.
Quality Control and Assurance
▸ Purpose of Quality in Food Processing
Quality Assurance Programs
▸ Using Quality Assurance Programs
▸ The Big Eight plus Four
Prevent Allergen Cross-Contact
▸ Following an Allergen Control Plan
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FOOD SAFETY: FACILITY SECURITY

Maintaining a safe and secure facility takes the effort of each employee to be vigilant and report anything
unusual. By following a food defense plan, quality controls and security procedures, facilities can produce
goods that are safe for consumers. This course discusses security initiatives common to any food facility and
shares how regulatory agencies assist in the compliance of these procedures.
Defending Food Safety
▸ Receiving Quality Materials
Security Throughout the Facility
▸ Understanding Security Plans
Audits and Inspections
▸ Inspections in a Food Facility
▸ Operational Training
▸ Forklift Pre-Operational Inspection
▸ Forklift Operational Inspection
▸ Lifting Boom Use
Personal Protection of Workers
▸ Personal Clearances
▸ Hierarchy of Fall Protection

Protective Equipment
Personal Protective Equipment
PPE016

SAFETY MATTERS: PERSONAL PROTECTIVE EQUIPMENT

Safety Matters: Personal Protective Equipment shows employees the proper PPE to use for the various
hazards they may face in their workplace. It discusses the responsibilities of both the employer and the
employee for wearing, maintaining, and replacing appropriate PPE for specific tasks.
Hazard Assessment
▸ Hazard Sources and Assessments
Responsibilities
▸ Responsibilities of the Employer and Employee
Head Protection
▸ Importance and Maintenance
Hearing Protection
▸ Types and Maintenance
Eye and Face Protection
▸ Types and Use
Hand Protection
▸ Types and Maintenance
Foot Protection
▸ Characteristics, Types and Inspection
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MLPP05

PAUSE FOR PERFORMANCE: EYE SAFETY

Help employees keep an eye out for dangers that can damage their eyes, and identify the equipment that can
provide the appropriate eye protection.

▸
▸
▸

Eye hazards
Types of eye protection
Inspection, cleaning and storage

MLPP02

PAUSE FOR PERFORMANCE: FOOT SAFETY

Are your employees aware of the hazards that can harm their feet? Educate employees and help them take
active steps to stay safety with the right footwear and safe practices.

▸
▸
▸
▸

When foot protection is needed
Protecting against hazards
Comfortable and practical fit
Inspection, cleaning and maintenance

MLPP04

PAUSE FOR PERFORMANCE: HEAD SAFETY

Get employees acquainted with different head protection gear and the hazards each equipment is designed to
protect. This program also discusses inspection, replacement, and cleaning guidelines.

▸
▸
▸

Types of hazards for head protection
Types of head protection
Inspection, replacement and cleaning

MLPP01

PAUSE FOR PERFORMANCE: HAND SAFETY

Protect your employees’ hands by helping them select, inspect, wear and care for the right kind of hand
protection. This program also covers the types of gloves and helps employees recognize hand hazards.

▸
▸
▸
▸

Potential hand hazards
Types of gloves
Select the proper hand protection
Inspection and care

PPE012

PERSONAL PROTECTIVE EQUIPMENT: THE RIGHT CHOICE

Are your workers too stubborn to wear their PPE? Give them a first-hand look at the tragic consequences
when they don’t. This course shares a worker’s testimony on how he was injured because he didn’t wear the
right equipment. Once your workers see what could happen, then perhaps, they’ll take their PPE seriously.
Personal Protective Equipment
▸ Head Protection
▸ Eye And Face Protection
▸ Hearing And Respiratory Protection
▸ Hand And Arm Protection
▸ Foot, Leg And Body Protection
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SAFETY MATTERS: HEARING PROTECTION

Give employees an overview of permissible noise levels, proper PPE and the elements of a Hearing
Protection Program.
Safety Matters: Hearing Protection helps employees:

▸
▸
▸
▸

Understand the major parts of the human ear
Know permissible noise levels
Identify the elements of a Hearing Protection Program
Wear the right PPE based on Noise Reduction Ratings

MLPP03

PAUSE FOR PERFORMANCE: HEARING SAFETY

Help reduce the risk of hearing loss among your employees with this program, which covers the different types
of hearing protection, as well as inspection, cleaning, and storage procedures.

▸
▸
▸
▸

Types of hearing protection
Earplugs
Earmuffs
Inspection, cleaning and storage

Respiratory Protection
MLMO01

PAUSE FOR PERFORMANCE: MOLD AWARENESS

Mold can practically anywhere. Although it’s not generally an issue, being exposed to mold that is untreated
can cause illness or damage property. Raise awareness and protect employees with this program.
It helps employees:

▸
▸
▸
▸

Recognize mold and signs thereof
Understand how and why it grows and spreads
Identify health hazards
Housekeeping and safety practices

MOL001

SAFETY MATTERS: MOLD AWARENESS

Help employees understand how, where, why mold spreads; recognize signs of mold growth; and prevent
mold exposure through housekeeping.

▸
▸
▸
▸
▸
▸

Recognize mold and signs thereof
Identify how and why it grows and spreads
Understand the impact of mold on the workplace
Determine common locations of mold
Identify mold-related health risks
Housekeeping and safety practices
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MOLD AWARENESS

There are hundreds of thousands of species of molds and fungi and they are literally everywhere. Many are
harmless, but some can cause flu-like symptoms, nasal stuffiness, eye irritation and wheezing. Although they
are tiny, mold spores pose big risks. With this course, your employees can examine the basic facts – what is
mold, how it grows, how it spreads, what it looks like – and the ways to reduce or eliminate it in your facility.
Mold Spores
▸ Life Cycle of Mold
▸ Routes of Entry into Indoor Environment
▸ Harmful Effects and Symptoms of Mold Exposure
Dealing with Molds
▸ Reporting and Preventing Mold Infestation
RES011

SAFETY MATTERS: RESPIRATOR SAFETY

Protect employees from atmospheric hazards with Safety Matters: Respirator Safety, which discusses the
different types of respirators; medical evaluation and fit testing; and the procedures for proper care, cleaning,
and maintenance of a respirator.
Recognize the functions of a respirator
▸ Understand employers’ training responsibilities
▸ Know the prescribed content for training
▸ Appreciate the Policy for Voluntary Use

RES005

DISPOSABLE RESPIRATORS: EXPOSURE CONTROL

Get training that fits your employees. This course surveys need-to-know info on disposable respirators,
covering standards, applications and different types. It examines the purpose the fit testing, the specs of
the three efficiency levels, the medical requirements for wearing respirators and the various maintenance
methods – the seal test, serviceability and replacement standards.
Disposable Respirators
▸ Disposable Respirators And Their Selection
Fit Testing And Donning
▸ Fit Testing
▸ Donning Your Disposable Respirator
Maintenance, Written Plan, And Voluntary Use
▸ Changing And Maintaining A Respirator
▸ Written Plan And Voluntary Use
MLRE02

PAUSE FOR PERFORMANCE: DISPOSABLE RESPIRATORS

Despite their throwaway design, disposable respirators are highly engineered products that help clean the air
as we breathe. They must meet rigorous testing standards, fit well, and be used properly.
This program helps employees:
▸ Recognize two main types of disposable respirators
▸ Identify efficiency levels and the meanings of N, R, and P
▸ Appreciate the value of medical evaluations
▸ Understand fit testing and voluntary use
▸ Perform a seal check
▸ Follow good facial hygiene
▸ Care, inspect, dispose of handle respirators properly
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PAUSE FOR PERFORMANCE: RESPIRATOR CARE

To protect you, a respirator must be in good condition. This clip helps ensure just that, showing you how to
inspect, clean, and disinfect your respirator. It discusses:

▸
▸
▸
▸
▸

Components to check before use
Reporting or discarding damaged respirators
Steps in and frequency of cleaning and disinfecting
Proper storage
Handling dos and don’ts

RES000

RESPIRATORY PROTECTION

Help your employees breathe easier with the important information covered in this course. It discusses the
nature of hazardous atmospheres, respirator types, medical evaluations and the written program, it also covers
various aspects of respirator use and maintenance. This online course will help your organization comply
with OSHA regulations.
Introduction
▸ Importance Of Respirators
Fundamentals
▸ Hazardous Atmospheres
▸ Types Of Respirators
▸ Medical Evaluations And The Written Program
Inspection, Wear, And Testing
▸ Inspection
▸ Donning A Respirator
▸ Fit Testing
Maintenance
▸ Decontamination And Cleaning
▸ Storage

MLRE03

PAUSE FOR PERFORMANCE: RESPIRATORY PROTECTION

Help protect employees from respiratory hazards. Show them what kind of respirator provides the required
protection, and remind them to follow proper procedures and safe work practices.

▸
▸
▸

Importance of respiratory protection
How respirators work
Using respirators
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EPA010

ENVIRONMENT MATTERS: ENVIRONMENTAL AWARENESS

Discusses several laws that regulate the EPA’s four main focus areas: air quality, water quality, waste materials
and emergency planning, and chemical safety and use.

▸
▸
▸
▸
▸
▸
▸
▸

Clean Air Act
Clean Water Act
Safe Drinking Water Act
Resource Conservation and Recovery Act
Comprehensive Environmental Response, Compensation and Liability Act (CERCLA)
Emergency Planning and Community Right-to-Know Act (EPCRKA)
Toxic Substances Control Act (TSCA)
Federal Insecticide, Fungicide, and Rodenticide Act (FIFRA)

ENV000

ENVIRONMENTAL AWARENESS PART 1: AIR AND WATER

Keep the environment clean and comply with EPA regulations. This course explains how you can abide by
the major laws for air and water safety – the Clean Air Act and Safe Drinking Water Act. It explains how
organizations can pollute air and water sources and cites specific practices – SDS use, dust-and-vapor control,
monitoring, equipment maintenance, spill management, NPDES and water discharge permits – that can help
eliminate potential air and water pollutants like hazardous chemicals and petroleum-based products.
The EPA
▸ History
▸ Overview
Air Quality
▸ Overview Of The Clean Air Act
▸ Pollution Sources
▸ Types Of Pollution
▸ The Clean Air Act: Safe Work Practices
Water Quality
▸ Overview And Effects Of Pollution
▸ The Safe Drinking Water Act
▸ Point And Non-point Source Overview
▸ Permits
▸ Safe Work Practices
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ENVIRONMENTAL AWARENESS PART 2: WASTE AND CHEMICAL

SARA, CERCLA, EPCRA, TSCA and FIFRA – these are the complex EPA laws that your employees must
understand and comply with to keep the environment safe. Train workers on the nuances of these laws and
show them how various practices – SDS use, PPE, labeling, proper containment, spill management, cleanup
methods and documentation – can keep wastes and chemicals from polluting the environment.
Waste Materials
▸ Cradle To Grave Regulation
▸ RCRA – Overview
▸ Employer Permits And Responsibilities
▸ Safe Work Practices
▸ Hazardous Waste Cleanup – CERCLA
▸ Community Right-To-Know – EPCRA
Chemical Safety And Use
▸ Overview
▸ TSCA – New And Existing Chemicals
▸ Uses Of TSCA
▸ TSCA Safe Work Practices
▸ Pesticides – FIFRA
▸ FIFRA Safe Work Practices

RCR004

ENVIRONMENT MATTERS: LARGE QUANTITY GENERATORS

Explains how the EPA’s Resource Conservation and Recovery Act (RCRA) applies to the operations of Large
Quantity Generators, from production to disposal.

▸
▸
▸
▸
▸
▸

Name the EPA’s three source lists of waste
Recognize the four categories of waste and their codes
Manage training and documentary requirements
Understand requirements for notification, storage, and satellite accumulation
Follow disposal and transportation regulations
Adopt emergency prevention and contingency plans

RCR003

ENVIRONMENT MATTERS: SMALL QUANTITY GENERATORS

Explains how the EPA’s Resource Conservation and Recovery Act (RCRA) applies to the operations of Small
Quantity Generators, from production to disposal.

▸
▸
▸
▸
▸
▸

Introduction to RCRA
Identifying hazardous waste
Notification of hazardous waste activity
Transportation procedures
Waste minimization program
Emergency plans
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ENVIRONMENT MATTERS: SPCC

Outlines the three major components of the formal written plan, and shows how organizations can prevent,
manage, and respond to oil spills.

▸
▸
▸
▸
▸

Identify the three components of the formal written plan
Understand the causes of spills
Appreciate the importance of routine maintenance
Use various control measures
Apply countermeasures in cases of spills

EPA008

SPILL PREVENTION & CONTROL: INSURING A SAFER WORLD

Remember, a spill of one gallon of oil can contaminate a million gallons of water. It’s worth taking the time
to be sure your workers are familiar with the control and countermeasure steps in case of a spill at your
facility. This course emphasizes the procedures and safeguards required by the Spill Prevention, Control and
Countermeasure (SPCC) Federal guidelines. It provides important information for workers in facilities that use,
handle or store oil near waterways, including safe work practices, regulation requirements and what to do
in an emergency.
Spill Prevention And Control

▸
▸

SPCC – Rule, Philosophy And Requirements
Spill Prevention, Control And Countermeasure

EPA011

ENVIRONMENT MATTERS: STORMWATER RUNOFF

Covers best management practices (BMPs) and standard operating procedures (SOPs) that help mitigate the
risks of stormwater runoff.

▸
▸
▸
▸

Understand the causes and risks of stormwater runoff
Identify the three components of The National Pollutant Discharge Elimination System
Recognize the health and environmental hazards of stormwater runoff
Apply best management practices and SOPs

RCR001

RCRA: LARGE QUANTITY GENERATORS

Be on your toes when working with hazardous waste. This course helps you understand Resource Conservation
and Recovery Act (RCRA) guidelines on the use and maintenance of large quantity generators. Safe and
effective hazardous waste management requires a commitment from everyone – from CEOs to workers. This
course explains each person’s responsibilities in operating large quantity generators and in complying with
EPA standards.
The Hazardous Waste System
▸ Large Quantity Generators
Waste Identification
▸ EPA Requirements
▸ Source Lists
▸ Waste Characteristics
▸ Hazardous Waste Activity Notification
Storage Requirements
▸ Temporary Storage
▸ Containers
▸ Storage Areas

50

SAFETY COURSEWARE
DESCRIPTIONS
Transportation Procedures
▸ Requirements And Guidelines
▸ DOT Regulations
▸ Manifests
▸ TSD Facilities
Waste Minimization Program
▸ Management Options
▸ EPA Guidance
Administrative Responsibilities
▸ Prevention And Preparedness
▸ Emergency Coordinator
▸ Contingency Plan
▸ Personnel Training
▸ Good Recordkeeping

RCR000

RCRA: SMALL QUANTITY GENERATORS

Clean up the mess and get an overview of this landmark legislation. This program covers hazard waste
identification and notification, waste minimization program, emergency plans and transportation procedures.
Follow RCRA requirements and dispose both your waste and potential legal liabilities. Give your employees an
overview of this landmark legislation. This program covers hazard waste identification and notification, waste
minimization program, emergency plans and transportation procedures.
The Hazardous Waste System
▸ Small Quantity Generators – Commitment To The Future
▸ Regulations
Waste Identification
▸ EPA Requirements
▸ Source Lists
▸ Characteristics Of Waste
▸ Hazardous Waste Activity Notification
Storage Requirements
▸ Temporary Storage
▸ Containers
▸ Storage Areas
Transportation Procedures
▸ Requirements And Guidelines
▸ DOT Regulations
▸ Manifests
▸ TSD Facilities
Waste Minimization Program
▸ Management Options
▸ EPA Guidance
Administrative Responsibilities
▸ Emergency Plans
▸ Good Recordkeeping
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Emergency Action Plan/Emergency Response
Bloodborne Pathogens
BBP044

BLOODBORNE PATHOGENS: DON’T TAKE THE RISK

Blood carries necessary elements throughout the body, helping our bodies run smoothly. But when blood
becomes contaminated, our bodies do not work properly. Infectious microorganisms, called bloodborne
pathogens, can enter the body in a number of different ways. Once certain bloodborne pathogens enter, there
is no cure.
Bloodborne Pathogens: Don’t Take The Risk! will introduce you to the different diseases caused by bloodborne
pathogens, how to decrease your risk of becoming infected by these infectious microorganisms, and what to
do if you come in contact with them.
Understand the Risks
▸ Common Bloodborne Pathogens
Lower Your Risk
▸ Exposure Control
▸ Tasks that Create Risk
▸ Hepatitis B Vaccine
▸ Safe Work Practices
Handling Emergencies
▸ Personal Protective Equipment
▸ Cleaning Up Blood or Body Fluid
▸ Labeling Waste
Exposure and Follow Up
▸ Protecting Yourself After Exposure

MLBB01

PAUSE FOR PERFORMANCE: BLOODBORNE PATHOGENS

Remind employees to pause before taking any action when there is a possibility of exposure to blood or other
potentially infectious material. Help them protect themselves from bloodborne pathogens by taking extra
precautions and working safely.

▸
▸
▸
▸

What are bloodborne pathogens?
How bloodborne pathogens spread
Lower your risk
Safe work practices
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First Aid
FAD012

SAFETY MATTERS: CPR AND AED

Shows employees how to perform CPR on children, teens and adults.

▸
▸
▸

The five links of the cardiac chain of survival
CPR procedures for adults, children, teens, and adults
Life-saving functions of the Automated External Defibrillator, or AED.

FAD011

FIRST AID

This course stresses the importance of first aid and identifies the common injuries that occur in the workplace.

▸
▸
▸
▸

Bleeding
Electrical shock
Bone injuries
Burns

MLFD01

PAUSE FOR PERFORMANCE: BLEEDING

This course explains five major ways to deal with bleeding injuries.

▸
▸
▸
▸
▸

Assess the situation
Prevent exposure from bloodborne pathogens
Stop the bleeding
Clean and protect the wound
Know when to get professional medical help

MLFD03

PAUSE FOR PERFORMANCE: BONE INJURIES

This clip helps employees understand how to provide first aid to those with bone injuries. Showing how to
provide basic treatment, it explains dos and don’ts and helps employees:

▸
▸
▸
▸

Understand the differences between fractures and dislocations
Appreciate the need to immobilize the injured area
Use ice packs to reduce swelling
Identify the cases that need emergency medical attention

MLFD04

PAUSE FOR PERFORMANCE: BURNS

This clip identifies several types of burns and their varying levels of severity. It shows employees how to:

▸
▸
▸

Differentiate the different degrees of burns
Treat major and minor burns
Identify cases when it’s imperative to call emergency assistance.
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Fire Safety
FIR014

SAFETY MATTERS: FIRE SAFETY

Safety Matters: Fire Safety covers important safety matters like how fires start, how to prevent them, and
how to fight a fire if you ever find yourself face-to-face with the flames.
How Fire Starts
▸ Three components needed to start a fire
Fire Prevention
▸ Identifying common fire hazards
▸ Knowing the conditions for potential fires
▸ Housekeeping methods
Classes of Fire
▸ Characteristics of class A, B, C, D, and K fires
▸ Proper type of fire extinguisher for each class
Fighting or Fleeing a Fire
▸ RACE method
▸ How to use a fire extinguisher including
PASS method
▸ What to do after the fire is out

EXT005

SAFETY MATTERS: PORTABLE FIRE EXTINGUISHERS

Get an overview of fire safety. Help employees identifies the five major types of fires; the appropriate
extinguisher for each; the R.A.C.E. and P.A.S.S. methods, housekeeping, and electrical safety.

▸
▸
▸
▸

R.A.C.E. Method
P.A.S.S. System
Housekeeping and electrical safety
The risk of electrocution in putting out Class K fires

MLFE01

PAUSE FOR PERFORMANCE: FIRE EXTINGUISHERS

Give employees a quick overview of fire extinguisher use, including the PASS method, and help them discern
when and how they ought to use a fire extinguisher.

▸
▸
▸

Fire extinguishers
Before using a fire extinguisher
Using an extinguisher -- PASS
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EME063

SAFETY MATTERS: EMERGENCY ACTION PLANNING

Show employees what they — as a group and as individuals — need to do during emergencies.

▸
▸
▸

Define and understand the importance of Emergency Action Plans (EAPs)
Identify the five key elements of an EAP
Understand the roles of the coordinator, the warden, and individual employees.

MLEV01

PAUSE FOR PERFORMANCE: EMERGENCY EVACUATIONS

Fires. Workplace violence. Chemical and biological incidents. Sometimes when the unexpected strikes,
evacuation may be the only course of action that can keep you safe. You need to understand your facility’s
emergency reporting procedures, as well as the different alarms, conditions, and responses related
to an evacuation.

EME062

SAFETY MATTERS: ACTIVE SHOOTER PREPAREDNESS

Active shooter incidents or ASIs are an unfortunate reality and a growing threat to every workplace. In order
to help prevent mass casualties, knowledge and planning are critical. This program shows workers how to
identify an active shooter and emphasizes the importance of every employee having a plan, being aware of
his or her surroundings, and knowing the organization’s emergency action plan.
This course addresses how to report suspicious activity as well as how to respond in an ASI by determining
when it’s best to run, hide or fight. The course will conclude by mapping out what to expect and how to
respond when law enforcement arrives at the scene.
Preparing for an ASI
▸ Planning Makes a Difference
Suspicious Activity
▸ Reporting Suspicious Activity
Responding to an ASI
▸ First Things First
▸ Run
▸ Hide
▸ Fight
▸ Arrival of Law Enforcement

EME061

SAFETY MATTERS: SECURITY AT WORK

Every organization is susceptible to threats that can have a spectrum of negative effects. These threats can
range from technological ones to bomb scares to intruders.
Safety Matters: Security At Work builds awareness about facility security. It discusses various types of
threats and proactive measures you can take to prevent them. It also outlines how to act in case one is faced
with a threat in the facility.
Technological Threats
▸ Phishing
Biological Threats
▸ Bioterrorism
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▸ Chemical Threats
Explosives and Bomb Threats
▸ Explosives and Terror
Keeping Yourself Safe
▸ Stay Alert

EME011

FACILITY SECURITY: THE CRITICAL LINK

Never assume that your facility is safe. In this post 9/11 era, we’re painfully aware that a terrorist attack can
strike in any form, anytime, anywhere, and you have to understand the possible threats to eliminate them.
Tighten up your security with this course and see how and why human intelligence is the critical link to safety.
Code Of Crime
▸ Motive And Means
▸ Opportunity
Emergency/security Situation Reaction
▸ Perimeter Security
▸ Chain Of Security
▸ Tightening Security

MLEQ01

PLANNING FOR DISASTERS: EARTHQUAKES

Striking without warning and causing potentially massive structural damage, earthquakes are among the most
devastating natural disasters.
Planning for Disasters: Earthquakes shows employees what to do before, during, and after an earthquake.
The program discusses:
▸ Drop, Cover, and Hold
▸ Emergency supply kit
▸ Emergency contact list
▸ Different responses for different locations
▸ Safety clean-up procedures

MLFL01

PLANNING FOR DISASTERS: FLOODS

Floods can damage property, destroy crops, and claim lives. Particularly dangerous are flash floods, where
water rises quickly from an intense downpour or rushes in from snow melts or bursting dams.
Planning for Disasters: Floods helps employees take the necessary precautions and respond before, during,
and after a flood.
The program discusses:
▸ Identification of flood-prone areas and flood risks
▸ Constant media monitoring
▸ Flood response measures
▸ Emergency contact list and supply kit
▸ What to do in case in case one cannot evacuate
▸ Vehicle and driver safety
▸ Post-flood safety measures
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PLANNING FOR DISASTERS: HURRICANES

With the power to cause serious property and environmental damage and even death, hurricanes are among
the most devastating natural disasters. One of the few natural disasters that can be forecasted, it’s vital to
know if you are within the path of a hurricane and how to prepare accordingly.
Planning for Disasters: Hurricanes outlines the steps to take before, during, and after a hurricane.
The program helps employees:
▸ Know what items to have in an emergency supplies kit
▸ Secure their homes with good housekeeping
▸ Recognize areas to avoid at home during a hurricane
▸ Practice constant monitoring and communication
▸ Avoid post-hurricane hazards
▸ Conduct safe clean-up operations.

MLHU01

PLANNING FOR DISASTERS: LIGHTNING

Even before a storm’s high winds and rain have reached your immediate area, lightning can already strike. It’s
essential that you take the necessary precautions to help avoid tragic incidents.
Planning for Disasters: Lightning guides employees on what to do before, during and after a lightning storm.
The program tackles:
▸ Constant media monitoring
▸ Taking shelter
▸ Electrical safety and equipment maintenance
▸ Housekeeping and evacuation
▸ Safety out in the open
▸ Post-lightning storm safety

MLTN01

PLANNING FOR DISASTERS: TORNADOES

If you live in an area where tornadoes are common, it is critical to know the signs that a tornado is forming and
to take the necessary precautions.
Planning for Disasters: Tornadoes discusses what employees should do before, during and after a tornado.
The program touches on:
▸ Constant weather monitoring
▸ Emergency plans and tornado drills
▸ Safest areas at home
▸ Emergency supplies kit
▸ Housekeeping and furniture safety
▸ In-vehicle safety

▸

Post-tornado safety measures
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BAK009

SAFETY MATTERS: BACK SAFETY

Year after year, back injuries are one of the leading causes of on-the-job injuries. Help your employees
protect their backs with the information presented in this course.
Why Back Safety is Important
▸ Different categories of back injuries
▸ What is microtrauma?
Risk Factors, Injuries, and Warning Signs
▸ Typical causes of back injuries
▸ Signs that you may have a back injury
Anatomy – Spine and Back Basics
▸ How the back functions
Prevention and Maintaining a Healthy Back
▸ Technique for proper lifting
▸ Tips for protecting your posture
▸ How your general health effects your back

BAK008

BACK IN ACTION

Help improve awareness and cultivate individual responsibility when it comes to back safety issues in general
industry. Show your employees how proper lifting techniques and a pro-active health regimen can go a long
way toward maintaining a properly aligned spine, a strong core and overall better quality of life.
Back Basics
▸ The Anatomy Of The Back
Identifying And Preventing Back Injuries
▸ Warning Signs
▸ Understanding Risk Factors
▸ Practicing Preventive Measures

MLBA01

PAUSE FOR PERFORMANCE: BACK SAFETY

Remind employees to take time before doing any job to consider how to do it safely. Help them follow proper
procedures and safe work practices to avoid back injuries. Protecting their backs from injury is a huge step
toward staying safe on the job.

▸
▸

Causes of back injuries
Reduce your risk
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PAUSE FOR PERFORMANCE: SAFETY LIFTING TECHNIQUES

Help prevent back injuries through proper lifting techniques. Show employees correct posture, positioning,
and lifting motion.

▸
▸
▸
▸
▸
▸
▸

Distance from load
Shoulder and feet positioning
Squatting and bending
Back alignment
Gripping and stomach muscles
Breathing guidelines
Setting down the load

ERG015

SAFETY MATTERS: STRAINS AND SPRAINS

Most people will experience strains and sprains at one point or another. Avoiding risky behavior and
engaging in safe work practices are ways to actively sidestep the pain from these all too common injuries.
Safety Matters: Strains and Sprains helps increase employees’ knowledge of strains and sprains, their
differences and how to treat them.
Causes of Strains and Sprains
▸ How Strains and Sprains Happen
▸ Workplace Risk Factors and Individual Risk Factors
Strains and Sprains
▸ Signs and Symptoms
▸ Treatments
Preventative Practices
▸ Safe Working Techniques
Back Protection
▸ Back Basics and the Risk Factors
▸ Safe Posture

ERG013

STRAINS & SPRAINS: AVOIDING THE PAIN

Sprains and strains may not be considered serious workplace injuries, but they absolutely cause lost time,
reduce wages and disrupt employee health and productivity. Help reduce the risk of these injuries occurring
in your workplace with this training course. Show your employees how strains and sprains occur, how to
recognize their warning signs and how to minimize them with proper posture, exercises and other
simple adjustments.
Strains And Sprains
▸ How Strains And Sprains Happen
Avoiding The Pain
▸ Taking Control Of Your Posture
▸ Lifting The Right Way
▸ Protecting Your Body And Staying In Balance
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WORKPLACE ERGONOMICS

Help employees prevent musculoskeletal disorders (MSDs) and design an ergonomically friendly workstation.

▸
▸
▸
▸

Appreciate the importance of ergonomics
Identify the symptoms and causes of musculoskeletal disorders
Design an ergonomically friendly workplace
Adapt best practices from workstation assessments to position changes.

Maritime Safety
MRT026

BE PREPARED: MARITIME SAFETY

In order to work safely and avoid injuries and incidents on the waterfront, employees must pay attention to
how they are moving, climbing, and lifting while doing their jobs. This course prepares employees for their
work and shows them how to avoid slip, trip and fall hazards, properly lift and move heavy materials, avoid
heat stress, and gives specific safety tips for certain jobs.
Be Prepared
▸ Avoid Distractions
Slips, Trips, and Falls
▸ Causes and Prevention
▸ Ladder Safety
Back Safety
▸ Proper Lifting Procedures
Heat Stress
▸ Hazards and Prevention
Safety Tips
▸ Lasher
▸ Porter
▸ Holdman
▸ Mechanics
▸ Clerk
▸ Summary

BEWARE OF DANGEROUS & HAZARDOUS MATERIALS:
MARITIME SAFETY

MRT028

This course shows employees how to work safely around hazardous materials. It covers various hazard classes,
labels, dangerous cargo manifests, and how to handle an incident involving hazardous materials. It also looks
at confined spaces, the Hazard Communication standard, the Globally Harmonized System (GHS), and the
importance of Safety Data Sheets (SDS).
What You Need To Know
▸ Hazardous Materials
▸ Labels
▸ Dangerous Cargo Manifest
▸ Handling a HAZMAT Incident
▸ Confined Spaces
▸ Hazard Communication, Training and SDS
▸ Summary
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BULK OPERATIONS: MARITIME SAFETY

Whether employees operate bulk handling equipment, load bulk goods onto a ship with a system of conveyors
and free pour chutes, or are part of the cleanup crew, they must always work safely. This course identifies the
typical hazards employees will face and what PPE to wear. It also explains how to work safely in the hold and
during free pour operations and describes how to operate bulk handling equipment safely.
Be Prepared
▸ Common Hazards
▸ Personal Protective Equipment (PPE)
Bulk Cargo Handling
▸ Working in the Hold and Free Pour Operations
▸ Bulk Handling Equipment Safety
▸ Summary

MRT033

BULK RAIL SAFETY: MARITIME SAFETY

When working on or around bulk rail cars, you not only have to be cautious of the movement of the cars, but
also the individual, unique hazards of the material being carried in each car. This course shows how to prepare
for working bulk rail, including knowing the hazards, wearing the right PPE, having good communication, and
being prepared for train arrival.
Preparation
▸ Be Prepared
▸ Train Arrival
Bulk Rail Operations
▸ Procedures
▸ Safe Work Practices
▸ Summary

MRT032

CONTAINER RAILCAR SAFETY: MARITIME SAFETY

Working safely on or around container railcars requires that employees understand the hazards and how to
work safely. This course explains how to prepare for work with container railcars, how to work safely on and
around railcars, and how to communicate in the rail yard.
Preparation
▸ Clothing and PPE
▸ Train Arrival
Railcar Work
▸ Working on Railcars
▸ Working Around Railcars
▸ Communication
▸ Summary
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FORESEE YOUR SAFETY: MARITIME SAFETY

The waterfront is a dynamic and dangerous place to work, so it’s imperative that your employees work safely.
Show them how to use the 4 C’s of safety – competence, compassion, communication, and courage – to help
keep themselves and others safe on the job.
4C Your Safety
▸ The 4 C’s
▸ Competence
▸ Compassion
▸ Communication
▸ Courage
▸ Making Safety Happen

MRT029

GEAR UP FOR SAFETY: MARITIME SAFETY

Death and serious injuries can be avoided when your employees pay attention to some important safety
principles. One of these principles is making sure they have and understand how to use the proper safety
gear. This course identifies common Personal Protective Equipment (PPE) and the importance of wearing it
properly. The use of fall protection is also covered.
The Basics
▸ 4C Your Safety with the Right PPE
Equipment You Need
▸ Common Equipment
▸ Additional Equipment
▸ Fall Protection
▸ Summary

MRT034

RO-RO CARGO HANDLING: MARITIME SAFETY

Working on a RO-RO ship demands the utmost attention. Whether it is handling large, awkward equipment
or discharging the latest fleet of cars, there is constant movement. This course discusses wearing the right
Personal Protective Equipment (PPE), driving safely on and off RO-RO ships, handling used or unusual loads,
and working safely aboard an auto RO-RO ship.
Be Prepared
▸ Common Hazards and Injuries
▸ Personal Protective Equipment
RO-RO Operations
▸ Traffic Patterns
▸ Used or Unusual Loads
▸ Auto RO-RO Safety
▸ Summary
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VEHICLE OPERATIONS: MARITIME SAFETY

There are hundreds of vehicle collisions on marine terminals every year. This course explains how to make
safety happen when operating a vehicle on the waterfront. It covers how to be prepared for the hazards of
vehicle operation, pre-operational checks, defensive driving, and how to park safely.
Getting Started
▸ Vehicles – Be Prepared
▸ Pre-Operational Check
▸ Proper Vehicle Use
Safe Driving Practices
▸ Common Equipment
▸ Practice Defensive Driving
▸ Parking
▸ Summary

MRT031

WORKING AROUND VEHICLES: MARITIME SAFETY

Industrial vehicles and equipment help employees move loads quickly and efficiently, but the minute
employees forget about safety and take them for granted, they can turn deadly. This course will help make
safety a top priority when working around vehicles. It describes how to remain safe around moving vehicles
and equipment and how to work safely as a signalperson.
What You Need To Know
▸ Around Vehicles
▸ Signaling Safety
▸ 4C Your Safety

MRT036

WORKING WITH LOGS: MARITIME SAFETY

Working with logs can be a challenge but employees should always want to be on the safe side when they
handle this type of cargo. This course identifies the hazards of working with logs and what PPE to wear. It also
covers how to work safely with logs on the deck, from the water and dock, and in the yard.
Be Prepared
▸ Know the Hazards
▸ Personal Protective Equipment
Log Operations
▸ Safe Work Practices and Procedures
▸ Summary

MRT035

WORKING WITH STEEL CARGO: MARITIME SAFETY

Working with steel cargo takes tremendous skill, practice, and attention to safety. This course explains how to
work safely while loading, unloading, and sorting steel cargo. It identifies the hazards of working with steel and
what PPE to wear and it covers safe work practices and procedures to follow when working in the hold and in
the yard.
Be Prepared
▸ The Hazards You Face
▸ Personal Protective Equipment (PPE)
Steel Cargo Operations
▸ Working on the Vessel and in the Yard
▸ Summary
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PORT SECURITY FOR VISITORS, VENDORS AND CONTRACTORS

Help ensure your port’s security and productivity with this course, which can be used to familiarize outsiders
with what to expect when they enter a port or marine facility. This online course will help acquaint viewers with
Maritime Security Levels, Facility Security Plans, Restricted Areas, Incident Control, Drills and Exercises.
Port Security
▸ Security Levels And Plans
▸ Incident Control, Drills And Exercises
▸ Your Responsibilities
EME033

PORT SECURITY: WE’RE COUNTING ON YOU

Ports must be constantly protected and patrolled to sink dangers and maintain maritime security. Dock now
with this safety program, supplement your facility training and comply with the requirements of 33 CFR Part
105. The course discusses MARSEC levels, access control, vessel stores, bunkers, incident response, passenger
and ferry terminals, facility security plans and cargo handling.
MARSEC Levels
▸ Three Levels
Maritime Security
▸ Facility Security Plan
▸ Access Control
▸ Restricted Areas And Facility Monitoring
▸ Incident Response, Drills And Exercises
Other Marine Terminals
▸ Passenger, Ferry And Cruise Ship
Marine Facility Security
▸ Roles

MRT000

PERSONAL PROTECTIVE EQUIPMENT ON THE WATERFRONT

This course teaches the importance of wearing proper PPE on the docks – from the clothes worn to work to
the specialized gear determined by the job. Using video footage of actual dockworkers, it discusses different
types of common PPE, the importance of using PPE correctly, and how to inspect and maintain it. It also
covers special-use equipment and the importance of personal choices when it comes to wearing PPE.
Personal Protective Equipment
▸ Common Equipment
▸ Foot And Head Protection
Additional Equipment And Maintenance
▸ Additional PPE
▸ Other Protective Equipment And Maintenance

MRT003

WORKING AROUND VEHICLES ON THE WATERFRONT

Steer your employees to safety with this course, which trains them to avoid vehicular hazards on the
waterfront. It explains how they can identify high-risk areas, create a safety net and make the right potentially
life-saving choices. The course outlines pedestrian hazards, explains the nature of the bight, and cites various
dos and don’ts at the waterfront, including those for moving around and communication.
Working Around Vehicles
▸ High-Risk Areas
▸ Safe Work Practices
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SAFE DRIVING ON THE WATERFRONT

Convince your maritime workers to own their safety all the time. Remind them that every choice they make is
important to their safety and well-being. This course drives home the importance of safe driving on the job by
using interviews with dockworkers who were involved in motor vehicle incidents, some with tragic results. It goes
on to demonstrate safe driving techniques to follow, regardless of the vehicle. Safe Driving On the Waterfront
outlines operational rules and safety precautions unique to waterfront workplaces.
Safe Driving – Own Your Safety
▸ Safe Driving Techniques
▸ Rules Of The Yard

MRT006

WORKING SAFELY AROUND RAILCARS ON THE WATERFRONT

Stay on the safety track with this course, which teaches your employees to avoid train-related hazards. It explains
how your workers can plan, move, work and communicate. It cites various dos and don’ts for each process, and
outlines safety practices for the coupler release bar, platform use, the brake wheel, and dock aloft.
Plan, Move And Work
▸ Rail Plan And Communications
Working Safely On Railcars
▸ Working Around Railcars
▸ Safe Work Practices

MRT005

READY TO WORK ON THE WATERFRONT

This course informs workers on the waterfront about how to be fit on the job and how to identify back injuries,
their consequences and common causes. This program also covers the basics of injury prevention and how to work
smarter and make safety the first choice.
Staying Safe On The Waterfront
▸ Be Prepared
▸ Causes Of Back Injuries
▸ Back Injury Prevention

MRT007

SIGNALING ON THE WATERFRONT

Break the lines of communication and your operations can grind to a halt. Ensure that waterfront signaling systems
are smooth. Identify the vital communication dynamics among your signalmen, groundmen, drivers, gangway men
and crane operators. Raise awareness and master the various hand signals vital to every operation. This course,
which also advises on crane dynamics, is part of an eight-program series – On The Waterfront: Every Choice
Counts – which meets OSHA standards and outlines safe waterfront practices.
Signaling – Own Your Safety
▸ Communication Lines And Tools
▸ Safe Operations
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SAFETY MATTERS: SLIPS, TRIPS, AND FALLS

Slips, trips and falls make up a quarter of the injuries reported in the workplace. They can happen anytime,
anywhere, and are one of the leading causes of accidental deaths.
Safety Matters: Slips, Trips and Falls helps increase your employees’ knowledge and awareness on causes of
slips, trips and falls (STFs). It also describes organizational and individual steps you can take to reduce and
prevent STFs and make your workplace a safer environment.
Overview
▸ Definition of STFs
▸ Importance of preventing STFs
Causes of Slips, Trips and Falls
▸ Causes of slips
▸ Causes of trips and missteps
▸ Causes of falls
Organizational Practices for Preventing Slips, Trips and Falls
▸ Workplace and work processes design
▸ Good housekeeping
Individual Practices for Preventing Slips, Trips and Falls
▸ Safe walking practices
▸ Wearing proper footwear

MLFA01

PAUSE FOR PERFORMANCE: FALLS

Help employees recognize tasks that raise the risk of falls, and follow proper procedures and safe work
practices. With such, they can stay protected from fall-related injuries.

▸
▸

Causes of falls
Protecting yourself

MLSL01

PAUSE FOR PERFORMANCE: SLIPS & TRIPS

Protect employees every step of the way: when they climb up or down the stairs, or when they move from one
surface to another. Help them understand why slips and trips happen, and how they can be avoided.

▸
▸
▸
▸

Definition of slips and trips
Causes of slips
Causes of trips
Preventing slips and trips
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WALKING AND WORKING SURFACES

This course helps train your workers to be alert to changes in surface conditions, particularly in ramps and
scaffolds. It briefly explains the physics of balance and traction and shows how your employees can keep both.
The course also lists dos and don’ts for the different types of ramps and scaffolds, explains the nature of the
leading edge and cites various fall-arrest systems such as guardrails and safety nets.
Slip, Trips And Falls
▸ Traction And Balance
▸ Wet Surfaces
▸ Weather Hazards
▸ Other Slip Hazards
▸ Trips
Ramps
▸ Definition Of A Ramp
▸ Fixed Ramps
▸ Portable Or Elevating Ramps
Scaffolds
▸ Definition And Safe Work Practices
▸ Fall Protection
▸ Mobile Scaffolds
Elevating Platforms
▸ Start-up Inspections

PFP006

FALL PROTECTION CASE HISTORY

Falls can be fatal - too many families of fall victims can tell you that. In fact, falls are a leading cause of death
in many industries and they can happen from any height. That’s why it’s important for your employees to know
how to look for fall hazards and protect themselves against them.
Fall Protection Case History features a heart-wrenching interview with a mother who lost her son due to
a construction fall. This painful, real-life story sets the stage and shows your employees that incidents can
happen to them, or someone they know, if precautions aren’t taken.
The program also covers the Fall Hazards Control Process and how to use a Personal Fall Arrest System.
Fall Case History
▸ Incident Description
Lessons Learned
▸ Fall Hazards Control Process
▸ Personal Fall Arrest System (PFAS)
Dealing With A Fire
▸ Fires Happen
▸ Evacuation Plan
Fighting A Fire
▸ When To Fight A Fire
▸ Know Your Fire Extinguisher
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PERSONAL FALL PROTECTION: YOUR LIFELINES

Falls are the leading cause of death in many industries. Almost half of all fatal falls happen to workers within
their first six months on the job, and a quarter of them happen on small jobs involving 12 or fewer employees.
The surface an individual falls from doesn’t even have to be very high for it to cause a serious injury; half of
all fall-related deaths are from heights of less than 25 feet. This is why all workers, especially those working in
industries with high rates of injuries, should be educated on proper fall protection. Personal Fall Protection:
Your Lifelines provides important information on Personal Fall Arrest Systems (PFAS), hazard recognition, and
the fall hazard control process.
Personal Fall Arrest System (PFAS) and Fall Restraint
▸ PFAS Components
Hazard Recognition
▸ Hazards Associated with Fall Protection
Fall Hazard Control Process
▸ The Three Steps

PFP003

PERSONAL FALL PROTECTION FOR CONSTRUCTION

Even though OSHA standard 1926.500-502 was issued several years ago, more deaths still result because of
falls. Harness the vital knowledge to reach higher and tighter precautions. Keep your employees safe up
with this program.
Guardrail Systems
▸ Guardrail Basics
▸ Special Use Of Guardrails
Special Fall Protection Systems
▸ Safety Net Systems
▸ Warning Line Systems
▸ Controlled Access Zones And Monitoring Systems
Fall Arrest Systems
▸ Fall Arrest System Basics
▸ Body Harnesses
▸ Connectors
▸ Lifelines
▸ Lanyards And Deceleration Devices
▸ Anchorage And Tie-Off
Fall Prevention
▸ Positioning Device Systems
▸ Connectors For Positioning Devices
▸ Anchorage And Tie-Off For Positioning Devices
▸ Safe Work Practices
Equipment Maintenance
▸ Cleaning And Storage
▸ Inspection
Emergency Rescue Procedures
▸ Emergency Rescue Procedures
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PAUSE FOR PERFORMANCE: LADDER SAFETY

Ladder safety is not just about the climb. Show employees how ladders can put them at risk and introduce to
safe practices from set-up to the actual climb.

▸
▸
▸

Common ladder hazards
Safe ladder use
Climbing a ladder

SCA001

SCAFFOLD SAFETY

Each year, 4,500 workers are injured and 50 workers are killed because of loose scaffolding. But with this
instructive online course, your employees can fortify their know-how of this equipment and enhance safety
awareness. It covers the basics of scaffold construction and safety including hazard recognition, types of
dangers, proper use and maintenance, and accident prevention by using PPE and fall-protection systems.
Recognizing Scaffold Hazards
▸ The Basics
▸ Who Ensures Safe Scaffold Use?
Scaffold Construction
▸ Preassembly Inspection
▸ Safe Assembly And Inspection
Safe Work Practices
▸ PPE And Fall Protection
▸ Worker Safety
▸ Maintaining A Scaffold

General Safety
HEA012

SAFETY MATTERS: HEAT STRESS

Help employees recognize the symptoms of heat illnesses, and know what actions to take and what treatments to
seek for each.

▸
▸
▸
▸

Identify the different kinds of heat-related conditions
Understand contributing factors to such illnesses
Know the kinds of treatments and actions to take for each
Follow safe work practices, such as administrative and engineering controls.

MLHE01

PAUSE FOR PERFORMANCE: HEAT STRESS SAFETY

Keep your employees cool with this program, which helps them identify heat-related injuries, recognize the
symptoms of heat illnesses, and adopt measures to protect themselves and others.

▸
▸
▸
▸

Heat stress
Related heat injuries
Symptoms of heat illnesses
Protection from heat illnesses
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SAFETY MATTERS: OFFICE SAFETY

Complacency can often set in when working in an office setting, but hazards are lurking around every corner.
Familiarize your employees with the dangers they should be aware of.
Ergonomics and Back Safety
▸ The importance of using proper posture
▸ How to lift properly
▸ Causes of Carpal Tunnel Syndrome
Housekeeping
▸ Tips for preventing slips, trips, and falls
▸ Steps to avoid being struck-by or striking objects
Cuts and Pinch Points
▸ Safe use of paper cutters and box knives
▸ Identification of pinch points
Electrical Awareness
▸ Hazards of extension cord use
▸ General safe practices around electricity
Fire Safety
▸ Proper use of fire extinguishers
▸ Plan an evacuation route
Chemicals
▸ Importance of reading labels
▸ Safety Data Sheets (SDS)

WIN002

SAFETY MATTERS: WINTER SAFETY

Help protect your workers from cold weather conditions with information on cold stress and other illnesses,
as well as tips for safe winter driving.
Cold Weather Risks
▸ Symptoms of cold stress
▸ Signs of hypothermia, frostbite, and trench foot
▸ Common illnesses
Safe Work Practices
▸ Tips for staying warm when working outside
▸ Protective clothing for cold weather
Driving Safety
▸ Vehicle preparation for inclement weather
▸ Preparing a survival kit
▸ Safe driving tips

MLCO01

PAUSE FOR PERFORMANCE: COLD WEATHER SAFETY

Take action to protect your employees from cold-related illnesses and injuries before working outside in cold
temperatures. Taking a few extra precautions can keep everyone warm and safe on the job.

▸
▸
▸

Cold stress
Common types of cold stress
Protecting yourself from cold stress
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HSK000

HOUSEKEEPING: IT AIN’T LIKE THE MOVIES

In this course, your employees will see how poor housekeeping contributes to a dangerous workplace. Train
them to keep the workplace clean to help prevent accidents by eliminating clutter, storing materials properly
and removing spills.
Keeping The Work Area Clean
▸ Eliminating Clutter
Proper Storage And Removing Hazards
▸ Storing Materials And Eliminating Spills

HSK004

HOUSEKEEPING SAFETY: A TEAM APPROACH

Tripping on objects in a walkway, being hit by falling objects, and slipping on greasy, wet, or dirty floors are all
common incidents that can occur when good housekeeping is overlooked. Show employees the importance of
working together to maintain an orderly workspace in order to work safely.
The Basics
▸ Consequences and Benefits
Housekeeping Steps
▸ The 5 S’s
▸ Areas to Maintain
Housekeeping Responsibilities
▸ Maintenance and Repair
▸ Cleaning Responsibility
▸ Additional Concerns

MLHO01

PAUSE FOR PERFORMANCE: HOUSEKEEPING

Explain the procedures for and safety benefits of a clean, clutter-free, and organized workplace: reduced risk
from injuries and fatalities.

▸
▸

Benefits of good housekeeping
Housekeeping steps

WRH001

WAREHOUSE SAFETY: SAFE MATERIAL HANDLING

A warehouse can be a dangerous place to work. Vehicular incidents, hazardous material leaks from containers,
and the constant movement of large, heavy materials all pose serious risk to your employees. It’s important
that they understand these risks and know the strategies to avoid harm.
Personal Protective Equipment
▸ Where to Use PPE
Manual Material Handling
▸ Risks and Solutions for Material Handling
Chemical Handling and Storage
▸ Handling Chemicals
▸ Storing Chemicals
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Forklifts, Pedestrians, and Loading Docks
▸ Forklifts
▸ Pedestrians
▸ Loading Docks
Slips and Trips, Falling from Heights, and Falling Objects
▸ Slips and Trips
▸ Falling from Heights
▸ Falling Objects

MLWS01

PAUSE FOR PERFORMANCE: WAREHOUSE SAFETY

Acquaint employees with the hazards of warehouse work and give them an overview of safety practices.

▸
▸
▸

Warehouse safety
Warehouse injuries
Safety practices

STR011

EMPLOYEE WELLNESS: TAKING CARE OF YOU

This course explores the concept of wellness – the state of being at your physical, mental, emotional and
spiritual best – and shows practical, every day steps employees can take towards achieving wellness.
Education
▸ Health Screening For Cancer
▸ Heart Health
Prevention
▸ Healthy Choices
▸ Lifestyle Choices

MLDF01

PAUSE FOR PERFORMANCE: DEALING WITH FATIGUE

This program reminds employees to consider how fatigue could factor into the work they are doing – before
they start the job. Having a plan for how to deal with fatigue and taking steps to avoid it can help to them and
everyone around them safe on the job.

▸
▸
▸
▸

Fatigue
Acute or chronic
Dangers of fatigue
Dealing with fatigue

MLDS01

PAUSE FOR PERFORMANCE: DEALING WITH STRESS

Are your employees feeling the signs of stress? This is common and the good news is that they can manage
this feeling by taking the suggested steps to avoid it... to keep them relaxed and stress-free on the job.

▸
▸
▸

Common causes
Dangers of stress
Managing stress
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MLHW01

PAUSE FOR PERFORMANCE: HEALTH AND WELLNESS

Give employees simple yet effective tips for safe and healthy living both at home and in the office.

▸
▸
▸

Health and wellness
Health and wellness in the workplace
Ways to improve your health

MLHA01

PAUSE FOR PERFORMANCE: HANDWASHING

Show employees how and how long to wash their hands, and help them prevent the spread of illnesses to
themselves and to others.

▸
▸
▸

Spreading germs
When to wash your hands
Procedure

MLDE01

PAUSE FOR PERFORMANCE: DEVICE DISTRACTION

Remind employees not to use personal electronic devices while they perform a task. Keep them focused on the
job and their own safety.

▸
▸
▸
▸

Dangers of distractions
Types of device distractions
Where distractions happen
Avoid distraction

MLHL01

PAUSE FOR PERFORMANCE: HOLIDAY SAFETY

Don’t take out the fun out of your employees’ holidays. Keep them safe away from work with this program,
which alerts them to hazards and corresponding safety practices.

▸
▸

Potential hazards
Making the holidays safer

MLHT01

PAUSE FOR PERFORMANCE: HOTEL SAFETY

Book this program and help your employees stay safe while traveling. This program shows them pre-planning
practices and hotel dos and don’ts that can help ensure a safe and productive trip.

▸
▸

Pre-trip planning
Hotel dos and don’ts

MLZK01

PAUSE FOR PERFORMANCE: ZIKA AWARENESS

Stop mosquitoes before they bite and help prevent the spread of Zika virus. This program discusses how Zika
is transformed and lists the common symptoms of Zika.

▸
▸
▸

Zika symptoms
How Zika is transmitted
Protecting yourself
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FAC002

GROUNDSKEEPING SAFETY: DEALING WITH BUGS AND CRITTERS

Insects may be small, but they can cause serious and even fatal consequences. This course, designed
especially for public works employees, utility workers, government employees, grounds maintenance
personnel and other outdoor workers, provides essential information for their protection and general safety.
It outlines measures to prevent West Nile Virus, explains basic PPE, cites the dangers from snakes, wasps,
bees, fire ants, poison ivy/oak and illustrates crucial first aid principles.
Buzzing, Biting And Stinging Insects
▸ Mosquitoes, Bees And Wasps
▸ Fire Ants And Ticks
▸ Spiders And Caterpillars
Creeping, Crawling And Venomous Critters
▸ Venomous Snakes
▸ Rodents And Hantaviruses
Basic First Aid For Stings And Bites
▸ First Aid For Insect Stings
▸ First Aid For Snake Bites

FAC003

WORKING OUTDOORS: MOSQUITOES AND TICKS

Go all out against mosquitoes and ticks with this course, which helps your employees protect themselves
against Lyme Disease, Encephalitis, West Nile Virus, and other conditions. Show workers proven methods to
avoid deadly insect bites and how to detect early warning signs of these debilitating diseases.
Awareness Of Insects
▸ Mosquitoes 101
▸ Ticks 101
Outdoor Workers’ Safety
▸ Protection Against Insects
▸ Workers’ Responsibility

OSH005

OSHA: AN INTRODUCTION

No losses are acceptable when it comes to workplace injuries or fatalities, so the Occupational Safety and
Health Administration (OSHA) was established to develop and enforce job safety and health standards.
Introduce your employees to this agency and ensure that they gain a deeper understanding of its goals. This
program explains OSHA standards, the inspection process, citations and penalties and your responsibilities as
an employer.
OSHA: Past And Present
▸ History Of OSHA
▸ Mandate And Existing Standards
Setting Standards
▸ Consensus And Proprietary Standards
▸ General Duty Clause
▸ Understanding OSHA Standards
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Inspection
▸ Workplace Inspections
▸ Handling Citations And Penalties
Responsibility
▸ Responsible Employers
▸ Safety Program And Professional Liability
▸ Hidden Costs Of Accidents
▸ A Word About NIOSH

OSH007

OSHA: AN INTRODUCTION FOR CONSTRUCTION

OSHA has an entire section of standards devoted solely to the construction industry, and compliance is
mandatory. Help your supervisors, foremen and workers understand the mission and workings of OSHA with
this training course designed specifically for the construction industry. This program will give your employees
a better understanding of OSHA standards and will help them know what to expect in an inspection. It also
covers the process for handling citations and penalties.
OSHA: Past And Present
▸ History Of OSHA
▸ Mandate And Existing Standards
Setting Standards
▸ Consensus And Proprietary Standards
▸ General Duty Clause
▸ Understanding OSHA Standards
Inspection
▸ Workplace Inspections
▸ Handling Citations And Penalties
Responsibility
▸ Responsible Employers
▸ Safety Program And Professional Liability
▸ Hidden Costs Of Accidents
▸ A Word About NIOSH

SAF021

TAKE SAFETY HOME

People are three times more likely to get injured off the job than on the job. And, they are eleven times more
likely to die from a non-work injury than a job-related one. This course shares key concepts for transferring
safe work practices from the job over to everyday at-home scenarios.
Personal Protective Equipment
▸ Eye Protection
▸ Hearing Protection
▸ Hand Protection
Chemicals and Poisons
▸ Types of Chemicals
▸ Handling and Storage
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Portable Power Tools
▸ Common Safety Guidelines
▸ Electric Power Tools
Fires
▸ Common Sources of Household Fires
▸ Fire Safety
Protecting Your Back
▸ Lifting
Slips, Trips, and Falls
▸ Causes and Prevention
▸ Ladder Safety

CTR001

CONTRACTOR SAFETY: IT’S EVERYBODY’S BUSINESS

Fire prevention, fall arrest, HAZMAT, confined spaces – get an overview of these and other safety issues with
this course. Inform your employees of their and your responsibilities, train them to be alert to the myriad
dangers and teach them the dos and don’ts for various working scenarios to ensure everyone’s safety.
General Safety Requirements
▸ Slips, Trips And Falls
▸ Fire Safety
▸ Personal Protective Equipment
Standards And Procedures For Work Environments
▸ Permit-required Confined Spaces
▸ The Excavation Site
▸ Lockout/Tagout And Hotwork
▸ Chemical Process Safety Management Program And Hazardous Chemicals

Process Safety
CPS005

PSM: OVERVIEW

Heighten your employee’s awareness of Process Safety Management (PSM) with this course. Explore
the importance and benefits of process safety, the main components of the Process Safety Model, and
operational discipline. Finally, review a case study of a notable fire incident and see how it could have
been prevented.
Rationale for Process Safety
▸ What is Process Safety?
Components of Process Safety
▸ Process Safety Model
▸ Technology
▸ Facilities
▸ People
What Can You Do?
▸ Employee Responsibilities
▸ Maintain Operational Discipline
Incident Case Study
▸ Fire

76

SAFETY COURSEWARE
DESCRIPTIONS
CPS006

PSM: PROCESS TECHNOLOGY

Help employees understand Process Safety Information, or PSI, and how its implementation affects PSM.
This course defines PSI and why it is important, explains specific roles and responsibilities of PSI, and
describes how PSI links with other elements within PSM.
The Basics
▸ Definition, Purpose, and Importance of PSI
Utilization of PSI
▸ PSI Process
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs

CPS007

PSM: QUALITY ASSURANCE

How does the process of Quality Assurance (QA) and its implementation affect process safety? This course
looks at the process of QA, specific roles and responsibilities within an organization, and how QA links with
other process safety elements.
Rationale for Process Safety
▸ The Basics
▸ Definition, Purpose, and Importance of Quality Assurance
Utilization of Quality Assurance
▸ Quality Assurance Process
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs

CPS008

PSM: PROCESS HAZARD ANALYSIS

Give your employees a look at Process Hazard Analysis (PHA) and how its implementation affects process
safety. This course describes the four steps involved in the process of PHA, explains specific roles and
responsibilities, and shows how it links with other elements within process safety.
The Basics
▸ Definition, Purpose, and Importance
Utilization of PHA
▸ PHA Process
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs

CPS009

PSM: EMERGENCY PLANNING & RESPONSE

Requirements of Emergency Response Planning (ERP) include elements like identifying emergency response
scenarios, implementing preventive measures, and initializing training development drills. Give employees
important information on the importance of ERP and how it links with PSM.
The Basics
▸ Definition, Purpose and Importance of ERP
▸ Linkages to Other Elements and Programs
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ERP Requirements
▸ Identify Emergency Scenarios
▸ Preventive Measures
▸ Response Measures
▸ Roles, Responsibilities, and Authorities
▸ Training Development and Drills

CPS010

PSM: MECHANICAL INTEGRITY

Show employees how Mechanical Integrity (MI) requirements help improve process safety. Give them a look
at specific roles and responsibilities within an organization and how MI is linked with other process
safety elements.
The Basics
▸ Definition, Purpose and Importance of Mechanical Integrity
Utilization of Mechanical Integrity
▸ Mechanical Integrity Requirements
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs
CPS011

PSM: PRE-STARTUP SAFETY REVIEW

Employees will hear about Pre-Startup Safety Reviews (PSSR) and the consequences of not following this
review. This course also describes how to implement PSSR and shows how it links with other parts of PSM.
The Basics
▸ Definition, Purpose, and Importance
Utilization of PSSR
▸ PSSR Implementation
▸ Linkages to Other Elements and Programs

CPS012

PSM: OPERATING PROCEDURES & SAFE PRACTICES

Heighten employee awareness of Operating Procedures and Safe Practices (OP&SP), its purpose and the
consequences of not following the requirements. This course also identifies roles and responsibilities of
personnel who maintain compliance with OP&SP.
The Basics
▸ Definition, Purpose, and Importance of OP and SP
Utilization of OP and SP
▸ OP and SP Process
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs
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CPS013

PSM: CONTRACTOR SAFETY

Gain an understanding of Contractor Safety Management (CSM) and how it links with other elements of PSM.
This course defines contractor safety, its purpose, and the consequences of not following CSM requirements.
The Basics
▸ Definition and Purpose
▸ Importance of Contractor Safety
Utilization of Contractor Safety Element
▸ Contractor Safety Process
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs

CPS014

PSM: AUDITING

This course explores PSM Auditing and why it is vital to safe process operations. It identifies the
consequences of noncompliance and describes the three major steps of PSM Auditing. It also explains
linkages between PSM Auditing and other PSM elements and programs.
The Basics
▸ Definition, Purpose, and Importance of PSM Auditing
Utilization of PSM Auditing
▸ PSM Auditing Process
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs

CPS015

PSM: MANAGEMENT OF CHANGE – TECHNOLOGY & FACILITIES

Give employees an overview of Management of Change (MOC) as it pertains to technology and facilities
(MOC-T&F). Help them understand its purpose and importance, how the MOC-T&F process works and how it
links with other elements within PSM.
The Basics
▸ Definition of MOC and Its Purpose
Utilization of Management of Change
▸ The Management of Change Process
▸ Roles and Responsibilities
▸ Linkages to Other Elements and Programs

CPS016

PSM: MANAGEMENT OF CHANGE – PERSONNEL

Help employees develop a deeper understanding of Management of Change – Personnel (MOC-P), its
purpose and the consequences of not following MOC-P requirements.
The Basics
▸ Definition, Purpose, and Importance
Utilization of MOC-P
▸ MOC-P Process
▸ Linkages to Other Elements and Programs
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LIN007

LINE BREAKING: PLAN FOR SUCCESS

Seal off the risks with this program as you show employees the various aspects of line breaking, from
preparation and procedures to lockout/tagout and general safety practices.
Line Breaking
▸ Types Of Line Breaks
▸ Planning And Preparation
Performing Safe Line Breaking
▸ Personal Protective Equipment
▸ Job Execution And Incident Investigation
▸ General Safe Practices

CPS004

PROCESS SAFETY: PROTECTING EMPLOYEES

Any job-site incident can be tragic, but an incident at a chemical processing or manufacturing facility can
be catastrophic. Build your safety and risk management plan with this course, which stresses employee
involvement and examines the management of change, process hazard analysis, operating procedures,
emergency planning and response. It covers OSHA’s Process Safety Management Standard and the
Environmental Protection Agency’s Risk Management Program – both rules specifically designed for the
chemical processing industry.
Process Information And Hazard Recognition
▸ Process Safety Information
▸ Process Hazard Analysis
Operating Procedures
▸ Operating Procedures And Managing Change
Employee Training
▸ Training And Pre-startup Safety Review
▸ Operational And Maintenance Procedures
Emergency Preparedness
▸ Emergency Planning And Response
▸ Incident Investigation And Compliance Audits

Incident Investigation
INV001

INCIDENT INVESTIGATION: GETTING STARTED

Help get a solid understanding of how to conduct a thorough incident investigation with the first in this fourpart training series. You’ll see the purpose and importance of the investigation and why it is imperative in
helping to maintain a safer work environment.
Incident Investigation
▸ Importance Of Incident Investigation
▸ Your Roles And Responsibilities
Incident Investigation Process
▸ The 8-Step Process
▸ Step 1: Make Initial Response And Report
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INCIDENT INVESTIGATION: FORMING AN EFFECTIVE TEAM AND
GATHERING INFORMATION
INV002

Putting together an effective team to gather information is a key step in the incident investigation process.
Without the proper team in place, important details may get overlooked. This course, the second in our fourpart incident investigation series, covers how to put together an efficient investigative team and shows how to
conduct interviews using the right types of questions.
Step 2: Form An Investigation Team
▸ Forming An Effective Incident Investigation Team
Step 3: Determine The Facts
▸ Conducting Interviews
▸ Reflective Listening
▸ Interviewing Do’s And Don’ts

INV003

INCIDENT INVESTIGATION: ANALYZING THE FACTS AND CAUSES

Once you’ve interviewed witnesses and collected evidence, the data may seem overwhelming. What should
you do with that data? How do you identify key factors? This is the third part in our four-part incident
investigation series. It shows how to conduct a root cause analysis and follow a line of questioning that can
lead to underlying causes of an incident.
Incident Investigation Process
▸ Step 4: Determine All Contributing Factors
▸ Step 5: Determine Systems To Be Strengthened

INCIDENT INVESTIGATION: RECOMMENDATIONS,
COMMUNICATION AND FOLLOW-UP
INV004

The purpose of an incident investigation is to protect precious lives and take steps to prevent an incident from
happening again. In this course, the final part in four-part training series, explore the final three steps to the
investigation process.
Incident Investigation Process
▸ Step 6: Recommend Corrective And Preventative Actions
▸ Step 7: Document And Communicate Findings
▸ Step 8: Follow-Up
Incident Investigation Review
▸ Review Of Incident Investigation 8-step Process
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